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eeping its tradition of offering seamless integration and extensive functionality out-of-the-box, NetBeans reaches its second major release in
2006. It took the developer team just six months to create a product
that impresses by the sheer amount of new features it aggregates. Take
the new Enterprise Pack, for example. You have features ranging from

business process modeling to secure web services, to XML schema creation. Add to
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that a complete UML modeler, plus the full Java EE 5 support and other enhancements
in the core IDE… and there’s a whole new NetBeans world to explore.
This edition of NetBeans Magazine covers a range of new features in NetBeans 5.5
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and its main extensions while also delving into core Java technologies. A thorough
tutorial puts the new features in Java EE 5 through their paces, using NetBeans to
build a complete enterprise application with JPA persistence, EJB 3.0 components and
JSF. In it you see the way NetBeans IDE boosts productivity in enterprise development,
and how the new features in Java EE measure up in real-world scenarios. In two other
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articles, you learn step by step how to use the new visual BPEL designer to create and
test a business process, and also how to develop web services starting from Java SE
projects.
Module development is one of NetBeans’ strongest points, and in this edition a quickstart tutorial shows you how to develop a very useful plug-in module that connects to
Google Code Search (just add three lines of code and NetBeans does the rest). And a
comprehensive article about the NetBeans Platform presents the design ideas behind
NetBeans’ pluggable architecture. You see how to use the Platform to slash development time while improving software quality. Also watch modular development in action
in an application that pushes the concept to the limit.
UML modeling is covered in a novel way. Instead of learning each feature mechanically, you’ll see the modeling functionality at work by reverse-engineering a complete
Java application. Starting from a non-visual model, the tutorial builds a set of UML
diagrams that show all the relevant structure and behavior of an example app.
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Finally, in our opening section, we highlight the pervasiveness of the NetBeans community, by showcasing a sampling of NetBeans-related projects and initiatives from around the world. NetBeans adop-

Java and all Java-based marks are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and
other countries.
Although every precaution has been taken in the preparation of
this magazine, the publisher assumes no responsibility for errors
or omissions, or for damages resulting from the use of
the information herein contained.

tion is expanding on all continents, and the community is alive
everywhere.
Happy coding!
Leonardo Galvão

A Long Way

N

etBeans has come a long way. When a handful of students, back in
1996, started the project that was to become NetBeans, did they
know where it would all end? Aiming to write a Delphi-like Java IDE in
Java, they began the long journey that has now come to NetBeans
IDE 5.5. However, the most significant infrastructural change came

in the 4.0 release. The old “mount” system was replaced by a new project system,
fully based on Ant. Project tasks were carried out by Ant scripts, making them easily
extendable and freeing applications from lock-in in the IDE. The window system was
thrown out of... the window. It was rewritten, creating a state-of-the-art system that
was a joy to behold, and smooth and easy to work with.
Now, with the release of NetBeans IDE 5.5, another giant leap has been taken. Initially aiming to provide “only” full Java EE 5 support, the 5.5 release now also provides
“packs” that integrate the crown jewels of several other Sun tools into NetBeans IDE.
For example, together with the 5.5 release, we also have the final release of the SOAoriented Enterprise Pack, a preview version of the C/C++ Pack, and the Visual Web
Pack, which brings an award-winning set of visual tools for web development. On top
of that, UML modeling is supported and mobile developers have the Mobility Pack for
CLDC and Beta 2 of the Mobility Pack for CDC.
But, significantly, NetBeans is more than a set of tools. It is also a community, a
community which has grown exponentially over the past years. Many have testified
that the breadth of the package offered by NetBeans IDE is unsurpassed. And now,
while acquainting ourselves with the NetBeans IDE 5.5 release, we look forward to NetBeans IDE 6.0. The good rumors are many and the tension builds. Read through this
magazine and realize... there is even more in store in the coming period. NetBeans
has a lot to live up to and a growing community cheering it on.

Geertjan Wielenga
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Worldwide

NetBeans has never been more global. The NetBeans community is growing at a fast pace in countries on six continents. And with a number of ongoing localization projects, the IDE and Platform
are ever closer to developers around the world. Here we show a sampling of international NetBeans-related projects and initiatives, with special focus on geographical distribution.

The maps in this section are stylized and abstract, not reflecting exact geographic locations and country limits.

France/Belgium

Germany

The popular French-language developpez.net portal hosts
a very active NetBeans forum and FAQ. This volunteer-driven developer website counts among its members many
Java champions, and is a reference in the French-speaking
world, being featured as a Top-50 JUG at Java.net.

The recent NetBeans User Group Munich meeting brought international NetBeans evangelists and local NetBeans specialists to
Munich, Germany, where they delivered presentations to a packed
audience (why not create a NUG in your country too?). Also check
out the Munich NUG members’ Software Quality Environment
project (sqe.dev.java.net), which provides NetBeans integration for
software quality tools such as PMD, FindBugs and Checkstyle.

Czech Republic
Prague, the Czech capital is the birthplace of NetBeans
and home to the core NetBeans development team. Many
evangelists and executives have adopted the city as their
home. The Mobility Pack is also developed here.

Kosovo
Kosovo, a small province
governed by a United Nations
mission, will soon have its localized NetBeans version, with
translation to Albanian moving
fast. And the Kosovo developer
community is already creating
national-scale projects using
the NetBeans IDE.

Italy
The Italian Blue Marine application (bluemarine.tidalwave.it)
is being ported to the NetBeans Platform. Providing features
for managing the digital photography workflow, this beautiful
open-source Java application goes beyond photo organization
tools, and is very extensible due to its modular design.
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Egypt
In Egypt, the Plethora project, due out later this year,
will integrate NetBeans with Project Looking Glass,
the open-source 3D platform built with Java 3D. The
plug-in module, which is being developed by a group
of students in the American University in Cairo, will
provide code generation and a form editor.

U.S.A.
While the core NetBeans development is done in Prague, the lion’s share
of development for the Visual Web
Pack and the Enterprise and C/C++
Packs is done in the United States. And
this is where the NetBeans World Tour
kicks off every year, at JavaOne, San
Francisco.

Brazil
Brazilian Portuguese has
been chosen as an additional “official language”
for NetBeans (the others
are English, Simplified Chinese, and Japanese). By
the time you read this, the
Brazilian community, with
support from Sun and SouJava, will be putting the
final touches on the translations. The developer
community in Brazil is very
active, having started several successful NetBeans
projects, such as GreenBox (greenbox.dev.java.
net), a plug-in module and
framework that generates
code based on Spring, Hibernate, and JSF.

Panama
The Panama developer community has been actively adopting NetBeans are their main Java IDE,
using it both in university and commercial projects.
A sharp and up-to-date blog in Spanish, avbravo.
blogspot.com, highlights all things NetBeans.

Azerbaijan

Russia

In Azerbaijan, a large UNESCO-sponsored Java project
is being developed on the
NetBeans Platform. The Java
CDIS/ISIS project will allow
users to query UNESCO’s text
retrieval system, used for bibliographic and other databases
throughout the world, especially in developing countries.

Russia was the first country to have a community-only localized release
of NetBeans 5.0. The leader of the Russian translation effort also cofounded the fast-moving NetBeans Translation Project (translatedfiles.
netbeans.org). You can bring NetBeans even closer to your community by
helping out with the many ongoing localization projects, or by creating a new
one for your language.

China
The BlogTrader Platform (formerly Humai Trader – humaitrader.dev.java.net), currently being
developed in Beijing, China, is a
standalone open-source application built on top of the NetBeans
Platform, with source code organized as a NetBeans modulesuite project. The tool provides
features to track and analyze the
stock market, both from historical data and real-time feeds.

Japan
Japanese speakers have an
official all-Japanese NetBeans
community at ja.netbeans.
org. Community members
can contribute their own content to the site and translate
web content from netbeans.
org. Sun provides support in
reviewing, coordination, and
CVS commits.
Second Edition N 8
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Working with
the NetBeans
Platform and the
NetBeans Module
System
Tim Boudreau

runtime is an age-old problem. The historical solution is the fa-

of NetBeans module devel-

miliar one: linking to libraries in native applications – or finding

opment and using NetBeans

JAR files on the classpath in Java applications. These approaches

Module System and NetBeans

work but have some drawbacks. First, there is no version man-

Platform, and makes a gener-

agement. An application linking itself together at runtime has no

al case for modular software development

idea what versions of the libraries it needs. It also has no way

as a methodology for improving quality

to know if it is linking with a version which is old or incompatible

and productivity.

(perhaps you have heard the term “DLL Hell”). Second, this sce-

You’re probably familiar with the NetBeans

nario covers using libraries at runtime, but it makes no provision

IDE as a development tool. It is also a

for an application which is truly assembled at runtime – one which

platform for building modular applications

discovers its libraries on the fly, and may want to unload and up-

– even non-GUI applications. The NetBeans

date such libraries.

Platform is the underpinnings of the IDE.

The NetBeans Module System solves these problems. It is a

Think of it as a “generic desktop applica-

runtime container specifically designed for applications which

tion”. Underneath the NetBeans Platform

discover (and can update) their components at runtime. And it

sits the NetBeans Module System – the

specifically handles inter-library dependencies very explicitly – so

engine that launches NetBeans, discov-

the application cannot be started in a state where its dependen-

ers components dynamically and resolves

cies are not satisfied.

dependencies between modules. It’s the

Of course, not everyone is writing an application that needs

NetBeans Module System that makes it

to assemble itself at runtime. My point here, though, is that the

possible to download new modules and

NetBeans Module System may be relevant to you even if you

hot-deploy/redeploy modules at runtime.

are not writing such an application. There are benefits to modu-

A module is simply a JAR file with some
manifest entries that allow the NetBeans

lar development that go well beyond the capabilities of a runtime
container.

Module System to recognize it. All of the

Consider how NetBeans itself is developed: by a community of

APIs you can write to in NetBeans live in-

hundreds of people that spans several continents, time zones,

side modules. These are divided along func-

and teams. Our experience is that there are extraordinary ben-

tional lines. So, for example, if you want

efits to modular development unrelated to the runtime capabili-

to change the status bar text at runtime,

ties of the NetBeans Module System. They have much more to do

you will use a class called StatusDisplayer.

with engineering culture and sustainability of the product. In other

StatusDisplayer is part of the UI Utilities API.

words, these are benefits that may not apply to a one-off bit of

That API lives in a module (a JAR file) which

coding, but show up over time; benefits that improve the probabil-

your code can depend on. Building on the

ity of shipping a 2.0 after a 1.0, a 3.0 after the 2.0 and so forth.

NetBeans Platform is essentially writing

See more about these benefits below.

platform.netbeans.org

T

his article covers the basics

The NetBeans
Platform Web
site is the main
entry point for
NetBeans development on
the web, linking
to all other
development
documentation.
The tutorials
section (platform.netbeans.
org/tutorials)
is particularly
useful.

netbeans.org/download/dev/javadoc

E

Not Just an IDE

The NetBeans
API Documentation: a
comprehensive
set of all documentation for
all classes in
public APIs in
NetBeans.

code that interacts with these APIs, and
these APIs are implemented in modules

Avoiding code-entropy
Many projects start out well designed, and that design gradually

just like the ones you will create.

decays as features are added. The system becomes more tightly

The case for
modular development
Dynamically

linking

applications

coupled as expedient implementation of features creates new
dependencies between parts of the application. This means it gets
at

harder and harder to fix bugs over time. Because as the code
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becomes more coupled, fixing a bug in one place is more likely to

buggy XML parser on all application’s boot

create a bug somewhere else.

classpath, you know ahead of time that
your application will not have a problem.

Enforcing API design

The NetBeans
Developer FAQ:
a comprehensive knowledge
base of NetBeans development information. In addition
to frequently
asked questions, it contains
many tips, tricks
and otherwise
hard-to-find
information,
along with simple descriptions
of common
API classes and
where to start
to do various
tasks. Since it is
a wiki, if you get
an answer to a
question that
is useful to you,
you are encouraged to add it
to the FAQ.

wiki.netbeans.info/wiki/view/NetBeansDeveloperFAQ

A module in the NetBeans Module System cannot reference

Why build on NetBeans?

classes in another module without declaring a dependency on that

Whether or not you are convinced of

other module, and that other module agreeing that the classes referenced

the benefits of modular development in

are ones that are actual API. A NetBeans module by default has no

general, the NetBeans Platform can save

API – other modules can’t see its classes. Modules that have APIs

a huge amount of time for anyone devel-

specifically say what packages they are exporting. Other modules

oping a Swing application. In any desktop

can only reference classes from other modules if those classes are

application, there is a certain amount of

in packages the other module says it exports.

“plumbing” that must be written, such as

In practice what this means is that contracts between components in

wiring up menu items and toolbar buttons

the system must be planned out, not just developed in an ad-hoc way.

to actions, persisting settings, doing win-

While ad-hoc development may be slightly faster, over the long haul,

dow management and data presentation,

when you factor in the cost of maintaining that code (usually this

accessing resources, saving state on

is much more expensive than writing it in the first place), it pays

shutdown, and much more. None of these

off to have a system that makes it hard to write dirty hacks and

things are the business logic of the appli-

encourages you to create good contracts between components.

cation – they are the overhead of writing
a desktop app. This is stuff that is neither

Design hygiene

fun nor interesting to write, and can addi-

Since a module can hide most of its packages, this has the side

tionally be a source of bugs that drains off

effect that you can essentially have public classes that are only public

development time better spent working on

within the JAR they live in. Think about this for a minute – how many

logic that is the meat and potatoes of what

times have you piled an enormous number of unrelated classes into

the application does.

one package, so those classes could use package-privateness to

With the NetBeans Platform, you get to

hide their implementation details from the outside world? If you can

reuse all of this logic – and you are reusing

have public non-API classes (classes that can only be seen inside

an implementation of it that has years of

their own JAR), you can write much cleaner APIs – even provide

engineering and quality assurance invest-

packages that are pure API. Any API designed in this way has a

ed in it. The letter shown in the sidebar

better chance of being understandable to the people who will have

in the opposite page was not empty

to use it.

hyperbole (nor was it solicited). The NetBeans Platform can make the difference

Comfort in deployment
With the NetBeans Module System you know that your application can never be started if it cannot satisfy its dependencies. This

between wondering how you will ever get a
project finished and being able to outpace
competitors with the speed of it.

translates into greater peace of mind when you release a new version
of your software. Of course, you’ll want to make it easy for a user to
satisfy those dependencies, and hopefully you’re shipping something

10 N NetBeans Magazine

Getting started in
module development

that is compatible with itself. But in terms of upgrades, not to men-

Getting started with NetBeans module

tion nasty situations where some other application has put, say, a

development is easy. There is not a great

Not Just an IDE

Platform Success
The lead developer of a team that had recently adopted the NetBeans Platform several years ago
had the following to say, one month into migrating to the NetBeans Platform. While this was said a while
ago, the Platform has only improved since then:

We estimate that we will manage to release a product by July, that is/has:
1. Faster time-to-market
2. More features
3. More stable
4. Lower R&D cost
5. Higher end-customer value
6. More extendible
7. Easier long-term maintenance
After the July release, we believe that we can exponentially increase our features, since existing
developers are now high on the learning curve and can mentor new developers joining us later. In fact,
the previous gloomy outlook of supporting all the features requested by the upper-management, are
now turned into optimistic enthusiasm to make the “Best Color Physics Software for the Textile industry
in the world”. And perhaps the “Color Physics” will be dropped when we include all the non-color related
features, and maybe “Textile industry” will be dropped when we support all color-sensitive industries,
such as plastics, printing, paint and food. Future will tell...
To all people out there, who are considering using NetBeans for non-IDE applications, I can only
recommend, the strongest, the OpenIDE Platform.
To all the NetBeans developers, working at Sun Microsystems, privately or elsewhere, thanks for bringing
to the world the most complete client-side framework I have ever seen.
Second Edition N 11
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deal of difference between developing modules to install in the IDE,

which are deployed together, and which

to use in a standalone GUI application, or for use in a non-GUI appli-

may

cation that uses the NetBeans Module System. The only difference

when implementing a single unit of func-

between all these things is which other modules will be included in

tionality, it is desirable to separate the

the application.

implementation into separate modules

The NetBeans IDE contains specific support that makes it easy

have

interdependencies.

(Often

which perform different functions.)

to build modules and applications, and then run, debug and deploy

3. Library Wrapper Module – A wrap-

them. Also, since all of this module building support uses Ant scripts

per module which allows you to embed

to do the work, setting up automated builds and other team sup-

any regular JAR library in the NetBeans

port is easy – all the metadata are human readable and can be put

Module System and call it. This will gen-

in a version control system such as CVS or Subversion. NetBeans

erate a wrapper module that contains no

5.0/5.5 contains three module templates that can be used to create

logic, but simply exposes the packages

a skeleton module (see Figure 1). These templates are:

in the library via its manifest, so that oth-

1. Module Project – An ordinary single module, with build script

er modules may call them.

and manifest. This type of module may be standalone or part of a
suite of modules.

2. Module Suite Project – A container for a collection of modules

A
Figure 1.
Creating a
new module
in the
NetBeans IDE

A1

The next step in the New Module Wizard
(Figure 2) is very straightforward. You define where on disk to put the module that’s
being created, and whether or not it should
be part of an existing suite of modules (you
can always add it to a suite later).
After this, you simply provide some basic
parameters that will identify your module
(see Figure 3). Each module has a unique
ID (Code Name Base). This is a string, and
by convention should match the base Java
package of your module, to avoid name
collisions. If your module exposes an API,
other modules will use this name to say

A
Figure 2.
Setting up the
module name
and location

A2

they depend on yours and should be granted access to your module’s public classes.
The Module Display Name property simply
provides a human-friendly name for your
module.

Expressing dependencies
between modules
It would not be much fun to develop modules if you needed to dig up the programmatic code name of a module in order to
use its classes. The NetBeans IDE makes
this easy. Your module’s dependencies are

12 N NetBeans Magazine
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a property of your module project, which
can be found in its properties dialog.

A3

A

A4

A

Since dependencies are between Java
classes, and you are probably reading the

Figure 3.
Defining
module
properties

JavaDoc documentation to find out about
them, you can simply add new dependencies by class name. Just open the module
properties dialog, and click Library|Add
Dependency. You will see a dialog like the
one in Figure 4.

Making modular
development easy
The point here is that developing in a
modular environment requires some additional bookkeeping. One module must say
what other module it wants to use; it also

Figure 4.
Adding
dependencies

can specify the minimum version it wants,
etc. Such bookkeeping should not mean
laborious work for the programmer. The
NetBeans IDE’s support for developing
modules takes care of the bookkeeping
quite completely, and provides a GUI for
adjusting dependencies that uses the elements a developer needs to know about
anyway: Java classes.
ture, you can create a modular application with no UI whatsoever.
Again, this is something that the NetBeans IDE makes simple. You

As mentioned above, there is little dif-

can, of course, use any IDE to develop NetBeans Platform-based

ference between writing modules that en-

applications. The NetBeans IDE simply makes it easier. Creating the

hance the NetBeans IDE, writing a GUI ap-

skeleton of an application is as simple as creating a new Module

plication or writing a non-GUI application.

Suite using the project template shown before. Deciding whether it

This too is a function of dependencies. By

will be a plug-in for the IDE or a separate application is a configura-

leaving the IDE modules out, and adding

tion step which can be changed at any time. The UI for this is part of

your own modules, you create a NetBeans

the properties dialog of the module suite. The first step is specify-

Platform-based application – one which

ing if the suite is to be a standalone application (with its own splash

uses the infrastructure and GUI of the

screen, name and other customizations), or just a set of modules

platform, without any IDE-specific appear-

to drop into the IDE (see Figure 5).

ance or functionality. By leaving out even

The next step is deciding what modules should and should not be

the core UI modules and just reusing the

part of the application. By default you are building against the copy

bootstrap and module system infrastruc-

of NetBeans you are running, but you can also build against a differ-

netbeans.org/community/lists

Not just for IDE plug-ins,
or even GUI applications

The
dev@openide.
netbeans.org
mailing list is
the place to ask
questions – you
will reach the
entire NetBeans
development
team at Sun, plus
thousands of
developers who
are building their
own modules and
NetBeans-based
applications.
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A
Figure 5.
Creating a
standalone
application

ent copy of NetBeans, such as the plain platform distribution. The GUI

distribution of your application (one click on

for deciding what modules are used is also part of the suite proper-

the suite’s popup menu will do that), this GUI

ties dialog (Figure 6). When you generate a zip or Java Web Start

also determines what modules will be pack-

A5

aged into your distribution. The UI for this is
the Libraries pane of the properties dialog.

Building the examples
NetBeans comes with some example
module code built in. In the New Project
Wizard, there is a category called Samples.
In it you can find two sample applications
built on NetBeans.
The Paint Application Sample App
In the NetBeans Module Projects category you can see a sample called Paint

A
Figure 6.
Choosing
components of
an application

A6

Application (see Figure 7). This is a prebuilt application consisting of three modules. The wizard allows you to unpack it
onto disk, build, run, debug and modify it.
The application’s functionality is simple.
It allows the user to draw on the screen
with the mouse, and save the result as a
PNG format image file. What is immediately
noticeable is that, while its UI is simple,
it is quite a polished application. It has a
splash screen, can save settings on exit,
supports editing multiple documents with
drag-and-drop windows, is fully localized,

A
Figure 7.
Creating
the Paint
Application
Sample App

A7

has menus and toolbars that are well designed and well behaved. And the initial
version of this application took all of 45
minutes to write!
If you look at the code, you will see that
the entire application’s logic is only four
Java classes, and two of those are trivial

Action implementations for creating new
documents and saving (see Figure 8).
The Paint Application sample (see it in action in Figure 9) consists of three modules.
They are:

1 N NetBeans Magazine
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A8

that second JAR depends on the first one). Such situations usually
mean there is a third piece which is the common functionality both
need, and that should be factored out into a single module both of
the others depend on.

A
Figure 8.
Structure
of the Paint
sample
application

Modular development In action
To really get a sense of the power of the modular development
paradigm, and what you can do with the NetBeans Platform, there
Application tutorial. Its source code can be found at imagine.dev.
java.net. The Imagine application takes the painting application design to an extreme of creating an application with the potential to
include functionality similar to that of GIMP or Photoshop.
It starts from the same premise as the original paint application, still uses the color chooser control and has a class called

PaintCanvas which is reminiscent of the Paint Sample Application.
But it goes much farther in having a powerful user interface, and



The Module Suite – This contains no

provides its own APIs to allow additional tools to be plugged in.

code. It simply allows the modules it contains to depend on each other and be deployed as a unit.

Imagine: a Modular Demonstration Application
Imagine is an image editor (see Figure 10). Much like other im-

The Paint Module – This is where the

age editors, it uses a model in which an image is constructed of

business logic lives. It contains the actions

image layers, each of which is independently editable. It has a pal-

and GUI components that you see in the

ette of tools which can be selected in order to use them to edit the

application’s main window.

image. And it has a number of windows in its UI, including a layers



The ColorChooser Wrapper Module

view, a customizer for the selected tool, a menu for effects that

– This is a no-code wrapper module for a

can be applied to a selection or a layer, the image editor itself, and

popup color chooser component (available

an edit history browser window.



from colorchooser.dev.java.net) which is
used on the toolbar in the application.

While this application is not ready to replace your favorite image

netbeans.org/community/sources

is a much enlarged and enhanced version of the original Paint

The NetBeans
Source Code: while
you don’t need the
sources to develop
your own code,
they can be an
invaluable source
of examples of
how to do things
right – simply
find a module that
does more or less
what you need to
do and see how it
works. All sources
are available via
anonymous CVS:
cvs -d:pserver:
anoncvs@cvs.
netbeans.
org:/cvs co
standard_
nowww will
download the
basic sources.

editor tomorrow, it is designed for extensibility, so that features can
be plugged in separately. And more importantly, it is designed so

Dependencies between components are

that its component parts have well defined contracts between them.

unidirectional – the Paint Module depends

It will be harder for a change in one

on the color chooser library, but the color

part of the application to break an-

chooser library knows nothing about the

other part. This is particularly use-

Paint module. Generally it is worth thinking

ful in the case that it would be de-

about dependency relationships between

veloped by people not physically in

pieces of a system before starting to

the same place. Building in an en-

code. Occasionally it will appear, in devel-

vironment that encourages healthy

opment, that circular dependencies (one

architectural practices has benefits

JAR depends on a second JAR’s class and

for the application’s maintainability.
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A
Figure 9.
Running the
Paint sample
application

The way that Imagine breaks up into modules is the interesting

the system will still function (though it

part. Each piece of UI you see – each window component (and,

won’t do very much). More importantly, it

incidentally, the effects menu), is implemented in a separate module

could be replaced by a totally different edi-

(Figure 11). Now, were this a production application, it might not

tor that operated on, say, SVG – and with

be broken up to quite this degree, but it demonstrates the power

the exception of the raster-based tools,

of this approach very well. The editor in the center of the window

the rest of the application would not need

comes from one module. It can be removed from the system and

to change one bit. The tools palette lives
in a separate module; it contributes the

A9

selected tool to a global selection context
which the editor component listens to. The
tool customizer is another module – one
which, like the editor, listens to the global
selection and if a tool appears in it, displays its customizer. The effects menu is
implemented in yet another module, which
locates all registered effects and provides
a UI for them. The editor window contributes the current image and its layers to the
global selection; the layers window listens
for this and displays the layers of the current editor. And so forth...
The truly interesting thing to notice is that

none of the modules I have just mentioned depend on (use classes from) each other. There
is a single module called Paint API which
defines Java classes such

A
Figure 10.
Imagine in
action

A 10

as Tool, Layer, Layers, and

Effect (see Figure 12).
Each of the other modules either provides or
consumes instances of
these classes; the communication

mechanism

is the global selection,
which uses a NetBeans
API class/concept called

Lookup (which is essentially a Map where the
keys are Class objects
and the values are one
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or more instances

A 11

A 12

A

simply depend on

Figure 11.
Modules of
the Imagine
image editor

the Paint API mod-

A

of the Class key. All
of

these

ule’s

modules

classes.

So

Figure 12.
Classes in the
Paint API

any piece can be
completely replaced
without

the

other

parts of the application being disturbed
in the slightest.
If someone develops additional tools
or effects, they can
be distributed as a new module. There

varying roles. Then deploy it using Java Web Start (JNLP), on an

is no need for recompiling the entire ap-

application server. The users log in to a web page; since they have

plication. The NetBeans Platform even in-

authenticated, the server knows who they are and what their job

C

cludes the optional Update Center module

is. The user clicks a link that starts the application via Java Web

(autoupdate), which will let you deliver new

Start. Depending on who they are, they will be delivered a different set of

modules and new versions of modules as

modules. The underlying APIs and business logic may be the same

simply as by putting some files on a web

across all users, but the user interface pieces and what functional-

server.

ity users have access to will vary depending on what they need to

Tim Boudreau
(tboudreau@sun.
com) had his first
startup when he was
13, and has been
hooked since, with
brief departures to
play rock and roll,
write and play music
and do graphics
and photography.
He is the coauthor
of NetBeans, the
Definitive Guide
from O’Reilly and
Associates, was
part of the team
that open sourced
NetBeans and
currently works as
a developer on that
project. Originally
from Massachusetts,
he lives in his
adopted home city,
Prague, in Czech
Republic.

do their job.

Role-based deployment
with Java Web Start

A similar scenario is one where an organization needs to produce
many different versions of an application with slight differences. For

Where this sort of thing gets really excit-

example, imagine an application used for both individuals and busi-

ing is when it comes to applications that

nesses to calculate or pay their taxes. Much of the logic underly-

are used by multiple types of users. The

ing either a business’s or individual’s work will be the same. These

showcase for this approach (and origina-

should be provided in modules common to the whole application.

tor of it) is Nokia NetAct – an application

There will be differences in the user interface, and in what function-

for managing cellular networks. The way it

ality is made available. Imagine deploying such applications, sharing

works is this. You have an activity which

all the code that should be shared between them, with no nasty

is information-based and involves many

hacks, no duplication, no extra testing needed, because the archi-

people; those people will have different

tecture you’re building on is designed for this sort of scenario!

roles and needs. Rather than optimize the
application for one set of users or create

Conclusions

multiple similar applications for different

It is my hope that this article has whetted your appetite to learn

roles, you create one application, with dif-

more about the NetBeans Platform and get some of the benefits of

ferent sets of modules to provide the UI for

it in your own code!
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Plug-in

to Google
in 3 Lines
Integrating Google Code
Search in NetBeans
Geertjan Wielenga

ule before, here’s your chance! This one could not possibly be

between Google and Net-

simpler.

Beans IDE started when Sun
engineer Ludovic (“Ludo”)

1. Creating the project

Champenois created on Oc-

Choose File|New Project. In the New Project wizard, choose

tober 5, 2005, a Google Search Toolbar

“Module Project” in the “NetBeans Plug-in Modules” category (see

for NetBeans IDE. This Google integration

Figure 1). Click Next. Name the project “GoogleCodeSearch”,

was so popular, and Ludo’s implementa-

and browse to an appropriate location. Select “Standalone Mod-

tion so cool, that it formed the basis of

ule” and “Set as Main Project” (if these are not already selected

the very frequently used NetBeans Google

by default). Click Next and then Finish.

netbeans.org/download/dev/javadoc

T

The unofficial relationship

NetBeans
APIs
documentation

Toolbar Module Tutorial. Since then, several enhancements have been built on top
of this toolbar. For example, NetBeans

A1

A

A2

A

user Ramón Ramos has added functionality allowing the user to select alternative
search engines, or to provide (instead of

Figure 1.
Creating
the Module
Project

a textfield) a right-click popup action on
the selected line or word.
Now that the new Google Code Search
has been announced (and to celebrate the
one year anniversary of Ludo’s Google
toolbar), it’s time for something else

e
s

quite special. And here it is... you can

a

development functionality (wizards and

integrate Google Code Search in
NetBeans IDE with only three lines of
code. That’s all that you need to do. The
NetBeans APIs and NetBeans IDE module
tools in the Source Editor) do everything

Figure 2.
Adding a
conditional
action

else.

The NetBeans module
Follow along and you will be able to
send a selection of code to Google Code
Search, from a Java file open in the IDE’s
Source Editor. In this article I’ve written
the steps for the complete beginner, so
if you’ve never written a NetBeans mod-

google.com/codesearch

e

Plug-in to Google in 3 Lines

Google
Code
Search
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A3

2. Adding and configuring an action
Right-click the project, choose New, and
then choose Action. Select “Conditionally
Enabled”, and in the Cookie Classes
drop-down choose “EditorCookie” (see
Figure 2). Click Next. In Category choose

NetBeans
Google
Toolbar
Module
Tutorial

platform.netbeans.org/
tutorials/nbm-google.html

Plug-in Modules

A
Figure 3.
Registering
the action in
the GUI

Tools, then unselect “Global Menu Item”.
Select “Editor Context Menu Item”. Choose
“text/x-java” from the Content Type dropdown list (this sets the MIME type, which
determines the type of file your new action is applicable to) – see Figure 3.
Click Next. Type “GoogleCodeSearch” in

weblogs.java.net/blog/ludo/archive/
2005/10/google_and_netb.html

Class Name, and “Google Code Search” in

Google
Search
Toolbar for
NetBeans
IDE

Display Name. Click Finish.
3. The first two lines
Right-click

the

project

and

choose

Properties. Select the Libraries category,
click Add and scroll to “Editor Library”
(see Figure 4). Click OK, and then OK
again. In the Source Editor, move to the

performAction() method, and remove the
line that you see generated; we won’t need
it in this module. Time for your first two
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A

A5

A
Figure 4.
Adding editing
functionality

A

you will need java.net.URL and org.openide.awt.HtmlBrowser.

URLDisplayer.
A red underline will remain, because the URL constructor

Figure 5.
Selecting the
menu item
sends the
selection to the
IDE’s default
browser,
opening it in
the Google Code
Search page.

throws MalformedURLException. Click on the lightbulb and let
lines of code! Add the following lines to

the IDE surround the code with a try-catch block.

performAction():
6. Installing and running
JTextComponent editor=Registry.getMostActiveComponent();
String selection = editor.getSelectedText();

Hurray, you’re done! Right-click the module and choose “Install/Reload in Development IDE” (then click OK). NetBeans
warns you that this action can be dangerous, but since this

The first line becomes underlined in red,

module is so simple, there’s little risk that we have a crasher

because you need import statements.

bug here. So you can ignore the warning – the new module

Thanks to the dependency on “Editor

will be hot-deployed and activated in the same NetBeans in-

Library”, you can click the lightbulb and

stance you’re using. (The alternative would be loading a new

choose org.netbeans.editor.Registry. Next,

NetBeans instance for testing.) Now select something in a

click on the lightbulb again and choose

Java file and choose the new menu item (see Figure 5).

javax.swing.text.JTextComponent.

Conclusions
5. Completing the code

Google Code Search is a powerful facility provided by Google.

Now go back to the Project Properties

In this article you’ve seen how easy it is to integrate it into

dialog box, and add a dependency on “UI

NetBeans IDE. Wizards did almost all the work, and you just

Utilities API”. Time for the final line of code!

needed to add three lines, the first two for selecting code and

Here it is, at the end of performAction():

the last for sending the selection to your browser. However,

URLDisplayer.getDefault().showURL(
new URL(“http://google.com/codesearch?hl=en&q=”
+ selection + “&btnG=Google+Search”));

When prompted for import statements,

although this module is simple, you have created a complete
module that plugs into NetBeans and can be very useful in your
development work. Congratulations, and have fun with NetBeans module development!

C
Geertjan Wielenga
(geertjan.wielenga@
sun.com)
has been a software
technical writer for
the past 10 years,
working mainly on
rapid application
development and
IDEs, currently
on NetBeans, but
previously on UNIFACE
by Compuware and
SuperNova by the
now-defunct Four
Seasons Software.
He works for Sun
Microsystems as a
Technical Writer on
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Java EE 5
in Action with

NetBeans

A critical exploration of Java EE 5’s new productivity features,
focusing on EJB 3.0, JPA, and NetBeans 5.5 tooling support
Osvaldo Pinali Doederlein

T

he traditional J2EE platform

time into analyzing the effectiveness of key Java EE features, ex-

has long been regarded as

trapolating them to real-world projects.

powerful but difficult to learn
and use: J2EE offers a massive number of high-end fea-

Installing NetBeans and
the Application Server

tures and it’s natural that these features

As this is NetBeans Magazine, I’ll assume that you know how to

have costs in complexity of architecture,

download, install and configure the IDE and a compatible application

APIs, and tools. Though NetBeans IDE

server. At the time of writing, NetBeans offers support for SJSAS,

has been offering strong support for J2EE

GlassFish, JBoss, WebLogic, and JOnAS (with the JOnbAS plugin),

development tasks for years, in an ideal

besides Tomcat. This tutorial was developed with the Sun Java

world tools should not have to mask the

System Application Server 9.0 (a.k.a. Java EE 5 SDK or Java EE

inadequacies of frameworks. Frameworks

5 RI), but it’s application-server-portable. Except that the example

should be well designed with respect to

application uses SJSAS’s predefined jdbc/sample data source – so

productivity – when this happens IDEs can

in other servers, you may have to configure a database and data

be “unloaded” from the automation of dumb

source.

jcp.org/en/jsr/detail?id=2

Java EE 5 in Action with NetBeans

Java EE 5
specification.

boilerplate code, and add an increasing
number of higher-end productivity features
without becoming, themselves, overloaded
with complexity.

The JPM Application
The example application allows you to keep track of all Java platforms, composed of JSR specifications and APIs grouped by pack-

You will see in this article, which shows

ages – deserving the pompous name “Java Platform Manager”.

off both the new Java EE 5 functionality

More specifically, the application manages a simple database, and

and NetBeans 5.5 features, that this is

is implemented with the JPA, EJB and JSF APIs.

exactly the case for the next generation of

Granted, due to space limitations I provide only a tiny amount of

enterprise Java development. We have a

the potential functionality of such an app. But when you reach the

much easier, yet richer, framework, along

end, I hope you’ll be so impressed by the ease of development of

with an increasingly powerful but still

Java EE 5 with NetBeans 5.5, that you’ll enjoy coding the rest of

seamlessly integrated IDE, with effective

it.

support for the entire Java EE stack.
This article puts the major productivity

Creating the Projects

enhancements of Java EE 5 through their

Start by selecting File|New Project>Enterprise/Enterprise Application.

paces. We’ll look at annotation-driven APIs

In the Name and location tab, set Project Name to JPM, change

in general, EJB 3.0, the Java Persistence

the base directory to an appropriate location, and accept defaults

API (JPA), Dependency Injection, and

for the other options (see Figure 1). This creates the projects

application deployment. All this while going

JPM, JPM-ejb and JPM-war. NetBeans adopts a project structure

through a tutorial that develops a simple

that mirrors the Java EE deployment structure, with one project for

but complete application with NetBeans

each deployable module (respectively the EAR, EJB-jar, and WAR

5.5 and Glassfish/SJSAS, and looking at

modules).

what NetBeans has to offer at the tool

You’ll notice that the deployment model is similar to the traditional

support side of Java EE 5. But differently

J2EE’s. But it was simplified, starting with the descriptor files, most

from most tutorials that focus on teaching

of which are now optional or much simpler. For example, though

new APIs or techniques, we’ll put some

NetBeans creates a JPM-ejb/Configuration Files/MANIFEST.MF and fills
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its Class-Path directive, this is often unnecessary. A Java EE 5 con-

wizards and editor provide default settings,

tainer will add all JARs inside an EAR to the classpath of all modules

e.g. Transaction Type=Container for all EJBs.

of that EAR without a Class-Path directive. For this tutorial, you may

But the container still requires the XML de-

remove the MANIFEST.MF file.

scriptor with all these settings written down
explicitly, thus polluting your projects with

Configuration by Exception
In Java EE 5, you can omit most configuration items for which the
container can reasonably guess a default value. This is clearly the
case of MANIFEST.MF/Class-Path.

Additionally, Java EE defaults are often
much smarter than simple fixed values for
missing properties. The automatic genera-

and for cases where defaults are not good enough. For instance, if

tion of classpaths is one example of non-

you need to force a specific class lookup order among several JARs,

trivial default logic. A more sophisticated

or if you want each module to import only the subset of JARs it really

example is DDL generation for persistent

needs, then Class-Path is still your friend. But these scenarios should

entities.

Even the traditional ejb-jar.xml is now optional. Look inside

JPM-ejb/Configuration Files. You won’t find any EJB descriptor, not

Implementing the
Persistent Entities

even after creating EJBs. On the other hand, you may still need pro-

Let’s start coding the JPM-ejb project,

prietary descriptors. For example, with SJSAS/Glassfish, the JPM/

starting with the persistent entities. The

Configuration Files/sun-application.xml file is required for settings such

application needs only three: Platform, JSR

as security role mappings. As it turns out, proprietary settings can-

and Package. These will be persisted by

not be moved from descriptors to code annotations. This is techni-

the Java Persistence API (JPA).

cally possible, but not a good idea. Annotations live in the source
code, and proprietary annotations would break portability.

Figure 1.
Creating
the Java EE
projects.

making its maintenance harder.

Explicit configurations are still supported, both for compatibility

be rather the exception than the rule.

A

additional files and redundant settings, and

The J2EE platform has been blamed for
requiring a heavy load of bureaucratic

Notice that the Configuration by Exception feature is not the same

artifacts even for simple tasks, so even

as the tool-supported defaults we’re more familiar with. For exam-

a three-entity design like ours would be

ple, even with J2EE 1.4, NetBeans won’t require that you write the

bloated with Entity Beans’ home and bean

ejb-jar.xml descriptor by hand. It provides a visual editor, and the

interfaces, lifecycle methods and descrip-

A1

tors. Not to mention code that’s not required (and not generated by IDEs) but is
often needed in practice: a layer of POJOs
to expose the Entity Beans to the outside
world, DAOs to encapsulate the use of that
code and convert between Entity Beans
and POJOs, a Service Locator to provide
resources like JNDI contexts, and so on.
This violates what I call Complexity
Scalability.

Simple

problems

should

produce simple code, even if the framework supports much harder requirements
like distributed transactions, clustering,
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declarative security and other high-end

ming, not flexibility or other factors.)

features of EJB. A good framework is “pay

In traditional J2EE, of course, we have the worst of the two

as you go”, not requiring any code or con-

worlds: an Entity Bean requires both a lot of code and a great

figuration that’s not really necessary. As a

deal of metadata. And its overhead scales linearly at best: complex

corollary, a great framework will allow even

apps require increased amounts of settings – for example, lots

complex requirements to map to relatively

of resource references from beans to other beans, data sources,

simple code: the bookkeeping overhead,

queues etc. – and the framework does nothing to avoid the need

measured as a proportion of the “useful”

to declare settings explicitly. Thus complex apps easily end up with

lines of code, should scale linearly.

numerous, long descriptors.

So, if a very simple artifact (like a persistent entity) can be programmed with 30

The Persistence Unit

lines of code and 3 lines of overhead (like

Before we can create any persistent entity, the JPA requires defini-

descriptor, annotation, external O/R map-

tion of a Persistence Unit. A P.U. is a set of JPA configurations (in

ping, implementation of API interfaces, or

other words, a descriptor). From the JPM-ejb project, run New>File/

equivalent), then the framework’s overhead

Folder>Persistence>Persistence Unit (Figure 2).

is 10% and its complexity scalability looks

The only interesting option here is Persistence Provider: for SJSAS

good – since a simple task is performed

or GlassFish, select TopLink(default). TopLink is an O/R mapping

with low overhead. For a much more com-

product from Oracle, but its Essentials version is open source. Users

plex artifact, like a thousand-line persis-

of other application servers may have to select a different provider.

tent class with many relationships, if the

NetBeans comes preconfigured also for Hibernate and KODO.

overhead is kept at 10% (100 lines), the
complexity scalability is good; if it drops
proportionally, e.g. to 3% (30 lines), it’s
awesome.
It’s an interesting exercise to evaluate
APIs and frameworks by this criterion. Take
Hibernate, for example. The framework is
regarded as easy to program, but its base
overhead is high. The mapping files for

E You can also ignore your application server’s default JPA provider and install
a different one like Hibernate in SJSAS. This is a big advantage of Java EE 5: JPA
supports “pluggable” persistence providers, instead of forcing you to go with each
server’s built-in implementation like in EJB/CMP. The loosely-coupled design of JPA
goes even further: you can use it in Java SE (without an application server), and you
can make the Persistent Unit descriptor refer to external proprietary descriptors,
like Hibernate’s .hbm files. This helps immensely in migrating legacy code.
NetBeans supports this flexibility by offering multiple providers, and allowing you
to configure new providers if necessary.

“dumb” persistent classes (with no busi-

The resulting Configuration Files/persistence.xml file is a minimal-

ness logic) are often more complex than

ist descriptor, only mandatory because it’s the only way to specify

the classes themselves, because there’s

“global” properties like the persistence provider.

no default logic at all. Every property and
relationship, however trivial, must be explicitly mapped, and the mapping is highly
redundant with the code. The same holds
for Spring applications. These often contain so much XML metadata that one won-

You could fill persistence.xml with the names of all persistent

A2

A
Figure 2.
Creating a
Persistence
Unit.

ders how this is any easier than keeping
the same information in Java code. (Note
that I’m looking only at ease of program-
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classes, but this is not normally needed, as the default behavior is to

delete this annotation from the id attribute.

automatically find all such classes (which is always good enough if

In fact, @GeneratedKey is illegal here be-

your EJB module contains a single P.U.). Finally, the persistence.xml

cause only numeric PKs can be auto-gener-

could include detailed mapping information, but this is also optional

ated.

because we can do all the mapping with code annotations (or even
more easily with default JPA behaviors).
The Platform entity
From the JPM-ejb project, select New>Entity Class. This brings
up the dialog shown in Figure 3. Make Class Name = Platform,
Package = jpm.entity and Primary Key Type = String. This wizard

E The entity’s hashCode() and equals() methods
are not necessary because the JPA will rely only on
the PK for identification and hashing of entities. But
if you use a custom class as primary key (which is
required to support multi-column keys), your PK class
must provide correct implementations of hashCode()
and equals().

will generate the code in Listing 1. This is simply a POJO, but let’s
consider some important facts:

JSR and Package entities

The class uses some JPA annotations: @Entity makes it a

Using the same New Entity wizard, cre-

persistent entity, @Id selects the attribute used for the primary

ate two new classes: JSR (Primary Key

key (PK), and @GeneratedValue declares that the value for this PK

Type = int) and Package (Primary key type

should be generated automatically.

= String). In the generated code, start by



 The entity must offer a default constructor, and JavaBeans-style
getters and setters for its persistent attributes or relationships.

deleting the @GeneratedKey annotations.
Next, rename the id attributes of these two
classes to JSR.number and Package.name,

Only the code in boldface is mandatory. The rest – hashCode(),

equals(), toString(), @Override annotations, implementation of

objects that can be
transferred through a
specific middleware;
whereas POJO implies
structure: objects whose

You will notice that NetBeans balks at

ming practices, but not required by the JPA. We’ll omit most of this

the new attribute names, showing a warn-

non-required code to simplify future listings. The exception is imple-

ing marker in the source editor with the

ments Serializable: this is not required by the JPA but is necessary

hover message “The column name of the

in our application because we want to transfer the entity objects

persistent field is a SQL-99 keyword”. Yes,

through (possibly remote) EJB calls.

too bad – number and name are reserved

The entities will double as DTOs (data transfer objects)1. In fact,

SQL keywords, and this can cause prob-

one of the first advantages noticed when moving from a traditional

lems in the generated tables because the

ORM tool to a POJO-based one is that there’s no need to write redun-

JPA engine will map each attribute to a col-

dant POJOs / Value Objects / DTOs. You also don’t need any code

umn with the same name, by default. Fix

to convert between persistent and non-persistent objects, nor the

this by adding @Column annotations, e.g.

structure (like the DAO pattern) to keep all that code organized.

@Column(name=”package_name”) to the
name attribute, which will remove the warn-

E JPA only requires two kinds of classes to be serializable: classes that map
composite PKs (with two or more columns), and the classes of attributes you may
want to map to a LOB column. Anyway, you’re better off if you follow the best practice
that all POJOs should be serializable.
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ings.
Relationships
Our Platform entity has a many-to-many re-

implementation does not
depend on specific APIs.

ters accordingly too.

Serializable – is just bonus from NetBeans. They are good program-

F1 Remember, the term
DTO implies a role:

respectively. Rename the getter and set-

The New Entity wizard always generates the @GeneratedKey anno-

lationship with the JSR entity (for example,

tation, but our application uses only natural keys, so you must also

JSR-224, the JAX-WS API, is part of both

Java EE 5 in Action with NetBeans

Java EE 5 and Java SE 6). Likewise, JSR

the new Platform.jsrs and JSR.

has a one-to-many by-value aggregation re-

platforms relationships. It’s use-

lationship with Package. Both relationships

ful also to have a constructor

are bidirectional.

that receives only the PK and

Start declaring a List<JSR> jsrs attri-

another receiving all attributes.

bute in Platform. Again NetBeans will show

The result should be close to

a warning: “The multi-valued entity relation

Listing 2, where are highlight-

is not defined”. If you left-click the attribute

ed the parts introduced after

name or select the warning marker and
right-click, NetBeans will offer two corrections for the problem. Select Create bidi-

A3

rectional “ManyToOne” relationship. This
shows the wizard in Figure 4.

A
Figure 3.
Creating
an Entity
Class.

A bidirectional relationship requires that
the entity in the other end, JSR, point back
to Platform. Accept the Create new field
option and Name = platforms. You must
add the getters and setters manually for

B�
Listing 1. Original code emitted for the Platform entity class (generated comments omitted).
package jpm.entity;
import java.io.Serializable;
import javax.persistence.*;
@Entity
public class Platform implements Serializable {
@Id
@GeneratedValue(strategy = GenerationType.AUTO)
private String id;
public Platform() {
}
public String getId() {
return this.id;
}
public void setId(String id) {
this.id = id;
}
@Override
public int hashCode() {
int hash = 0;
hash += (this.id != null ? this.id.hashCode() : 0);
return hash;
}
@Override
public boolean equals(Object object) {
if (!(object instanceof Platform)) {
return false;
}
Platform other = (Platform)object;
if (this.id != other.id && (this.id == null || !this.id.equals(other.id))) return false;
return true;
}
@Override
public String toString() {
return “jpm.entity.Platform[id=” + id + “]”;
}
}
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A
Figure 4.
Creating a
relationship.

creating the original entity code skeleton.

A

Note that the relationship wizard annotates Platform.jsrs with

@ManyToMany, and the new JSR.platforms with @ManyToMany(
mappedBy=”jsrs”). This mappedBy property is intended to avoid ambiguities, should Platform contain multiple collections whose elementtype is JSR. In our code this is not the case, so you could get rid of
that mappedBy, unless you think it makes the code easier to read (in
this case, you could add mappedBy=”platforms” to Platform.jsrs’s anTesting the Deployment

notation).
Now you can finish the JSR class by creating another bidirectional

The application’s persistent entities are

relationship with Package. This relationship will have a OneToMany

complete, so let’s test them. In the JPM

cardinality, so JSR will have an attribute of type List<Package> but

project run Deploy project. In a few sec-

Package will only need a simple reference to a JSR. Listings 3 and 4

onds you should see messages reporting

show the final code for these classes. I added a couple of tweaks to

success in the console windows.

the relationship annotations (which will be explained later).

The deployment operation will also create the necessary tables, because we have

B�
Listing 2. The complete Platform class.
package jpm.entity;
import
import
import
import
import
import
import

java.io.Serializable;
java.util.ArrayList;
java.util.Arrays;
java.util.List;
javax.persistence.*;
static javax.persistence.FetchType.*;
static javax.persistence.CascadeType.*;

@Entity
public class Platform implements Serializable
{
@Id
private String id;
@ManyToMany(fetch=EAGER, cascade={
MERGE, PERSIST, REFRESH})
private List<JSR> jsrs;
public Platform () {
}
public Platform (String id) {
setId(id);
}
public Platform (String id, JSR... jsrs) {
this(id);
setJsrs(new ArrayList<JSR>(Arrays.asList(jsrs)));
}
public String getId () {
return this.id;
}
public void setId (String id) {
this.id = id;
}
public List<JSR> getJsrs () {
return jsrs;
}
public void setJsrs (List<JSR> jsrs) {
this.jsrs = jsrs;
}
}

set the Persistence Unit’s Table Generation
Strategy to Drop and Create (or Create). You
can check this by connecting to the project’s
data source. If you’re using the recommended JavaDB sample database in SJSAS, this
will be predefined in Runtime>Databases>
jdbc:derby://localhost:1527/sample

[app

on APP]. Just run this node’s Connect command, log in with the password app, and you’ll
see the created tables. Notice, in particular,
that an associative table, PLATFORM_JSR, is
created to map the ManyToMany relationship
between Platform and JSR.
Annotations: Intelligence
and Limitations
As this article intends also to make a critical review of Java EE 5’s ease-of-use features, we can’t stop here, implying that all
persistence-related work will always be as
easy as in our simple example.
Many developers starting to use annotation-enabled APIs think that the new APIs
just shuffle things around – metadata that
used to be written in XML descriptors is
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now written in code annotations but

B�
Listing 3. The JSR class.

they have to be written just like before,
right?
Not really. As you can see in our example, we don’t have to create annotations for all metadata previously in descriptors. For example, there are no annotations declaring that JSR.description
is a persistent property, nor declaring
the mapped table for each entity. And
we only needed two @Column annotations for attributes whose names would
map to illegal SQL identifiers. We could
have been more verbose, writing code
like:
@Entity
@Table(name=”T_PLATFORM”, schema=”JPM”)
public class Platform implements Serializable {
...
@Column(name=”PK_ID”, nullable=false,
length=512).
private String id;
...

But these annotations are all optional.
If they are missing, the JPA will look at
the names and types of classes and
attributes, so a class named Platform
becomes a table named PLATFORM; a

String attribute becomes a VARCHAR
column, and so on. (If you want an
entity class to contain an attribute not
mapped to any column, tag it with the

@Transient annotation).

E In

principle, a framework based in
descriptors, like EJB 2.1 or Hibernate, could
also infer default configurations from the
application classes. But the tight coupling of
code and annotations, plus the availability
of standard and built-in APIs and tools to
manipulate annotated classes, make this
strategy more robust, efficient and easy to
implement.

package jpm.entity;
import
import
import
import
import
import
import

java.io.Serializable;
java.util.ArrayList;
java.util.Arrays;
java.util.List;
javax.persistence.*;
static javax.persistence.FetchType.*;
static javax.persistence.CascadeType.*;

@Entity
public class JSR implements Serializable
{
@Id
@Column(name=”num”)
private int number;
private String description;
@ManyToMany(mappedBy=”jsrs”)
private List<Platform> platforms;
@OneToMany(fetch=EAGER, cascade=ALL)
private List<Package> packages;
public JSR () {
}
public JSR (int id) {
setNumber(id);
}
public JSR (
int id, String description, Package... packages) {
this(id);
setDescription(description);
setPackages(new ArrayList<Package>(
Arrays.asList(packages)));
}
public int getNumber () {
return this.number;
}
public void setNumber (int number) {
this.number = number;
}
public String getDescription () {
return description;
}
public void setDescription (String description) {
this.description = description;
}
public List<Platform> getPlatforms () {
return platforms;
}
public void setPlatforms (List<Platform> platforms) {
this.platforms = platforms;
}
public List<Package> getPackages () {
return packages;
}
public void setPackages (List<Package> packages) {
this.packages = packages;
if (packages != null) for (
Package p: packages) p.setJsr(this);
}
}

Our sample application is also simplified by completely automatic
DDL generation. Even if you have to write some annotations detailing
types, table and column names, nullability and other properties, you
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B�
Listing 4. The Package class.

by many annotations, or else we’ll have to
write DDLs and manually keep them in sync

package jpm.entity;

with the classes. But this doesn’t mean the

import java.io.Serializable;
import javax.persistence.*;

JPA’s default behaviors are useless, but

@Entity
public class Package implements Serializable
{
@Id
@Column(name=”package_name”)
private String name;
@ManyToOne
private JSR jsr;
public Package () {
}
public Package (String name) {
setName(name);
}
public String getName () {
return this.name;
}
public void setName (String name) {
this.name = name;
}
public JSR getJsr () {
return jsr;
}
public void setJsr (JSR jsr) {
this.jsr = jsr;
}
}

only that you pay as you go. The JPA (and
other annotation-enabled APIs in Java EE 5)
requires a programming effort that’s proportional to the complexity of the problem
being solved, and not artificially inflated by
bookkeeping artifacts that must be written
whether you need them or not.

Implementing the
Session Bean
Now that we’re done with persistence, the
next step is to create a Session Bean that
exposes methods to manipulate and query
the persistent entities.
From the JPM-ejb project, run New>Session
Bean. Make EJB name=JavaPlatformManager

never have to collect these pieces into a CREATE TABLE statement.

and Package=business. Accept defaults

Thanks to automatic schema generation and SJSAS’s embedded

for Session Type=Stateless and Create

JavaDB database, we could write the whole app without even know-

Interface=Local, but check Create Interface

ing that a relational database is being used! These features allow you

=Remote. The wizard will create the skel-

to go far in your coding before you start worrying about “real-world”

etal sources for the Session Bean. These

issues.

include the class JavaPlatformManagerBean,
and the interfaces JavaPlatformManagerLo-

From Hello World to the Real World
Now, how realistic is the persistence code in this tutorial? In real
applications you often have to comply with strict rules for database

F2 Using a single
Java interface and
annotating it with both
@Local and @Remote
could be even easier,
but EJB 3.0 does not
support this further
simplification.
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cal and JavaPlatformManagerRemote. You’ll
just need to fill the blanks to obtain the
code in Listings 5 and 6.

schemas; you may have to use legacy tables, or follow a style guide-

Listing 5 shows the local interface for

line that says something like “all tables should have the prefix ‘T_’”.

the JavaPlatformManager bean. We have a

In the average case, you’ll be forced to tag every entity class with

@Local annotation, but we don’t need to

a @Table annotation, and every property with @Column or related

extend the interface EJBLocalObject any-

annotations (@JoinColumn and @JoinedColumns, not used in this

more. So we have a POJI (Plain Old Java

article). In the worst case, you may have to give up on the DDL

Interface).

generation feature, for example because your CREATE TABLE state-

The

JavaPlatformManagerRemote

inter-

ment must be highly tuned with fine-grained (and usually proprietary)

face (not listed) is identical, except that

clauses, like physical allocation or partitioning options.

@Local is replaced by @Remote. When

So in the worst case, our entity classes may be relatively polluted

you have both local and remote interfaces

Java EE 5 in Action with NetBeans

for a Session Bean, EJB 3.0 allows you to
refactor all common methods to another
interface, which is extended by both the
Local and the Remote interfaces2. This is a
big improvement from EJB 2.x, where this
refactoring and type unification was impossible because the remote interface was required to declare all methods with throws

RemoteException (EJB 2.0: 7.10.5) but the
local interface shouldn’t use this exception
(EJB 2.0: 7.10.7, 18.3.8, 18.6).
Listing 6 is the full implementation of
our Stateless Session Bean, qualified as
such by the @Stateless annotation. Notice how this class implements both the local and remote

B�
Listing 5. The Session Bean’s Local interface.

interfaces. In EJB 3.0, we finally
have the complete strong-typing

package jpm.session;

that EJB has lacked since its

import java.util.List;
import javax.ejb.Local;
import jpm.entity.Platform;

first version.
Now let’s analyze the bean
implementation. The @Persis-

tenceContext annotation does

@Local
public interface JavaPlatformManagerLocal
extends JavaPlatformManager {
void createPlatform (Platform plat);
List<Platform> listPlatforms ();
}

dependency injection for the

EntityManager, a JPA object that
stands behind a Persistence
Unit. When the JavaPlatform-

B�
Listing 6. The Session Bean’s implementation.

ManagerBean class is instantiated by the container, the

package jpm.session;

EntityManager em attribute will

import
import
import
import

be initialized before any method
can be invoked.
The method listPlatforms() runs
a query that returns all Platform
objects that were found in the database. These objects will have
their jsrs collections populated,
because we added the option

fetch = EAGER to the relation-

java.util.List;
javax.ejb.Stateless;
javax.persistence.*;
jpm.entity.Platform;

Java EE 5 SDK/
SJSAS, the Java
EE 5 Reference
Implementation.

@Stateless
public class JavaPlatformManagerBean
implements jpm.session.JavaPlatformManagerRemote, jpm.session.
JavaPlatformManagerLocal
{
@PersistenceContext private EntityManager em;
public void createPlatform (Platform plat) {
em.merge(plat);
}
public List<Platform> listPlatforms () {
return em.createQuery(
“select p from Platform p”).getResultList();
}
}

ship’s annotation. The EAGER op-
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tion in our example, forces a Platform entity’s associated JSRs to be

Who moved my lifecycle?

read when the Platform is read (possibly through a single query with an

Just like for JPA, the “pay as you go” rule

outer join, for better performance – a critical optimization if you need

also holds for programming EJB 3.0 compo-

the associated objects most of the time you need the parent object).

nents. For example, our session bean didn’t

Likewise, the JSR.packages collections will also come initialized.

need to implement any of the traditional lifecycle methods, such as ejbActivate(). But

JPA versus EJB

that does not mean that lifecycle control is

The fetch = EAGER option is also important for correctness in the

gone from Java EE. You can still hook into

example application, because we return the Platform objects through

events like creation or activation, but these

a (possibly remote) EJB invocation. Entity instances associated with

are now specified by annotations rather

an EntityManager are managed by the JPA. If we used fetch = LAZY

than interfaces. For example:

(the default), the query could return Platform objects with uninitialized

jsrs collections. These would be populated on demand, upon first
invocation of getJsrs(), but this only works for the original, JPA-managed collections.

@PostActivate
public void postActivate (InvocationContext ctx)
{
// Actions to execute after the activation
}

When you transfer these objects through an EJB call, the applica-

A
Figure 5.
The Web
GUI.
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tion at the other side of the call receives different objects (recon-

Annotations are finer-grained than inter-

structed through cloning or serialization/deserialization). The new

faces like SessionBean: you can implement

objects are not bound to an EntityManager. So when the receiver

only one of the lifecycle methods, ignoring

invokes getJsrs(), the JPA engine won’t do its magic of intercepting

all others.

the call and fetching the collection on demand. In fact, the receiver

Differently from the JPA entities, however,

will often be an application – like our JPM-war – that doesn’t con-

when programming EJBs you’ll find that

tain a persistence unit, and hasn’t even access to the entities’ data

most optional methods and annotations are

source.

rarely necessary, even in large, real-world

This issue is well-known to users of other POJO-based ORMs like

applications. In my experience with good

Hibernate, and the solution is the same: eager fetching. (And just like

old J2EE, I rarely had to implement any of

in Hibernate, instead of tagging the relationship with a fetch option

these lifecycle methods (well, if you don’t

that affects all loads, you can write queries with a FETCH JOIN clause

count paranoid-logging implementations

that gives finer control over when this loading strategy should be

that just report ““Bean XYZ was Activated”).

used.)

A5
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So the EJB 3.0 programming model re-

anything useful otherwise, so I’ll provide a sim-

sults in much tighter code, even for real-

ple web GUI with the subproject JPM-war.

istic applications.

Start by configuring the NetBeans project
to enable JSF. In the JPM-war project’s prop-

Implementing the
Web client

erties page, select Frameworks>Add, and
pick JavaServer Faces. This will populate the

Our application’s back-end is ready. All

project with the minimum required configura-

that’s missing is a GUI. I’m not much of a

tions (including sample JSPs we won’t use;

GUI programmer, but life has taught me that

delete those).

most people won’t believe my code does

The Web GUI contains a single JSP that allows

<%@ taglib uri=”http://java.sun.com/jsf/html” prefix=”h” %>
<%@ taglib uri=”http://java.sun.com/jsf/core” prefix=”f” %>
<html>
<head>
<title>Java Platform Manager</title>
</head>
<body>
<f:view>
<h:form id=”CreateTestData”>
<h:commandButton value=”Create Java SE data” action=”#{JPMClient.createJavaSE}”/>
<h:commandButton value=”Create Java EE data” action=”#{JPMClient.createJavaEE}”/>
</h:form>
<h:dataTable value=”#{JPMClient.allPlatforms}” var=”platform” border=”1”>
<h:column>
<f:facet name=”header”>
<h:outputText value=”ID”/>
</f:facet>
<h:outputText value=”#{platform.id}”/>
</h:column>
<h:column>
<f:facet name=”header”>
<h:outputText value=”JSRs”/>
</f:facet>
<h:dataTable value=”#{platform.jsrs}” var=”jsr” border=”1”>
<h:column>
<f:facet name=”header”>
<h:outputText value=”ID”/>
</f:facet>
<h:outputText value=”#{jsr.number}”/>
</h:column>
<h:column>
<f:facet name=”header”>
<h:outputText value=”Description”/>
</f:facet>
<h:outputText value=”#{jsr.description}”/>
</h:column>
<h:column>
<f:facet name=”header”>
<h:outputText value=”Packages”/>
</f:facet>
<h:dataTable value=”#{jsr.packages}” var=”pack” border=”0”>
<h:column>
<h:outputText value=”#{pack.name}”/>
</h:column>
</h:dataTable>
</h:column>
</h:dataTable>
</h:column>
</h:dataTable>
</f:view>
</body>
</html>

glassfish.dev.java.net

B�
Listing 7. The Web GUI’s view implementation, index.jsp.
Project
GlassFish.
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you to create sample Platform objects, and shows the ones already pres-

straightforward even though we’re using a

ent in the database. Listing 7 shows the source for this JSP, which is

remote interface.

built with JSF component taglibs. Figure 5 shows the page in action.

Looking again at Listing 6, check out the

The JSP requires a Managed Bean – a POJO that is registered in

implementation of the EJB’s createPlatform()

the WEB-INF/faces-config.xml descriptor, so JSF-based pages can

method. You only have to pass the Platform

access the bean’s properties and invoke their methods. Create it

object to EntityManager.persist(). The child

with New>File/Folder>Web>JSF Managed Bean; set Class Name to

JSR and Package objects are persisted by

JPMClient and Package to jpm.web, accepting other defaults. This

reachability. This happens because we de-

bean will provide the following services to our JSP:

clared the relationship Platform.jsrs with

 The property allPlatforms returns all Platforms (including child

the option cascade = {MERGE, PERSIST,

JSR objects and Packages), that the page will dump as nested HTML

REFRESH}, and JSR.packages with cascade

tables with JSF’s <h:dataTable> components.

= ALL.

 The methods createJavaSE() and createJavaEE() are event han-

The cascade rule indicates which persis-

dlers for JSF’s <h:commandButton> component’s action events.

tence operations are propagated by reach-

Each of these buttons triggers the insertion of one sample Platform

ability to associated objects. For Platform.

object in the database (after which the page will be updated).

jsrs we used MERGE (synchronization of the
object in memory with persistent records),

Listing 8 shows a simple controller implementation. There’s no

PERSIST (creation) and REFRESH (reloading

need of JNDI code to look up the Session Bean: just annotate it with

of persistent state to the object in memo-

@EJB, and dependency injection will do the rest. You don’t even

ry). For JSR.packages we used ALL, which

have to handle RemoteException, so the invocations to this EJB are

combines all the former with DELETE (dele-

B�
Listing 8. The Managed Bean.
package jpm.web;
import
import
import
import
import
import

java.util.*;
javax.ejb.EJB;
jpm.entity.JSR;
jpm.entity.Platform;
jpm.entity.Package;
jpm.session.JavaPlatformManagerRemote;

public class JPMClient {
@EJB private JavaPlatformManagerRemote jpm;
public void createJavaSE () {
jpm.createPlatform(new Platform(“Java SE 5”,
new JSR(176, “Java SE 5 Release Contents”,
new Package(“java.lang”), new Package(“java.util”), new Package(“java.sql”)),
new JSR(166, “Concurrency Utilities”, new Package(“java.util.concurrent”))));
}
public void createJavaEE () {
jpm.createPlatform(new Platform(“Java EE 5”,
new JSR(270, “Java EE 5 Release Contents”),
new JSR(220, “EJB 3.0”, new Package(“javax.ejb”))));
}
public List<Platform> getAllPlatforms () {
return jpm.listPlatforms();
}
}
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tion of the persistent data).
The default is not to cascade any operation. You should of course use the most
appropriate option for each kind of rela-

have to specify JNDI names. This is because EJB 3.0 generates
default JNDI names for all beans and even for resource references
that are implicit in dependency injection annotations like @EJB.
You can ignore these defaults and force explicit JNDI names;

tionship. Here, Platform↔JSR is a simple

for

association, so you could remove a JSR

@EJB(name=”ejb/session/JPM”). But once again EJB 3.0 default

from a Platform without destroying the

behavior here is widely applicable. I’ve seen few EJB applications

JSR, which is an independent entity (there

in which JNDI names are complex enough as not to allow use of

are some JSRs that are part of multiple

Java EE 5 defaults. For example, for the JPMClient.jpm resource

Platforms, and others that aren’t part of

reference, the system will generate the default JNDI name java:

any). But JSR↔Package is an aggregation

comp/env/jpm.web.JPMClient/jpm, which, by combining the fully-

by value. If you delete a JSR, its Packages

qualified class name and field name, should be unique enough not

should be deleted too.

to cause clashes.

Testing the complete application

Conclusions

example,

@Stateless(name=”ejb/session/JPM”)

and

Redeploy the application and load the

Java EE 5 is a major ease-of-programming release, built around

following URL in your browser: http://

many novel design ideas: configuration by exception, POJO-oriented

localhost/JPM-war/faces/index.jsp. (The

programming, annotation-driven APIs, dependency injection, a

URL will be different if you’ve installed the

state-of-the-art persistency API, and a streamlined component

application server to another HTTP port

model without hard-line rules like throwing RemoteException.

than 80 or used a different name for the

Nevertheless, Java EE is still a large, complex framework with

JPM-war project). Click both buttons; after

a boatload of features – and good IDE support still makes a big

each click a new Platform will be inserted

difference. NetBeans 5.5 offers a full range of Java EE-specific

and displayed in the updated page. Don’t

support: code-generation wizards; visual descriptor editors; code

click any button twice, as this would cause

completion, validation and automatic fixes for annotations; tight

a PK violation in the database.

integration with application servers and building of Java EE de-

Our job is not done, however, before

ployment packages, as well as JSP debugging, support for both

running the Verify project command on

Struts and JSF, and many useful utilities like database browsing

all projects. This submits each project

or HTTP monitoring. And we didn’t even get started with the really

to a massive number of Java EE-specific

advanced features, like SOA/BPEL tools in the Enterprise Pack. All

validations (in the results window I recom-

these features come out-of-the-box, without need of dealing with

mend selecting Display = Failures and

third-party plug-ins.

Warnings only). Make sure you’re clean on

The recent advances in the Java EE platform and the NetBeans

these validations to ensure both correct-

IDE should not only make enterprise-grade development simpler,

ness and portability.

but also easier to learn and more incremental. Many tedious and
error-prone tasks of the past are now gone, have been rational-

Look ma, no JNDI!
You may have noticed that we not only
avoided the JNDI APIs, but also didn’t even

ized, or are highly automated by powerful IDE support. This translates directly to higher productivity for all developers and a gentler
learning curve for beginners.
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WEB
SERVICES

T

his article illustrates how a web
service can be created and
tested as a NetBeans standard
Java Project. The new NetBeans

Create, consume and
deploy basic web
services productively
using NetBeans
Milan Kuchtiak

5.5 integrated support for JAX-

WS 2.0 enables you to easily create and consume web services.

Creating the web service
Start

NetBeans

5.5,

then

create

a

new Java Application project and name
it “GeometricalWS”. In the project’s Properties dialog select the Libraries category and
add “JAX-WS 2.0” (see Figure 1). This step

class with the code from Listing 2. Notice that the publish() method

or lower. Java SE 6 already includes the JAX-

requires the URL address for the web service and an instance of the

WS APIs.

CircleFunction class. The latter will be invoked to serve requests.

Now

create

a

Java

class

named

“CircleFunctions” with the code shown in
Listing 1. The @WebService annotation
makes the class a web service. The other

Run the application. The message in the output window will notify
you that the web service was published successfully:
Web service was published successfully.
WSDL URL: http://localhost:8765/GeometricalWS/CircleFunctions?WSDL

annotations declare the web service’s operations and their parameters, influencing

To check that the web service was really published, launch your

the automatic generation of a WSDL docu-

web browser and open the web service URL: http://localhost:8765/

ment for this class.

GeometricalWS/CircleFunctions?WSDL. The browser should show a

Using the javax.xml.ws.Endpoint.publish()

blogs.sun.com/pblaha/entry/
developing_web_services_for_mustang

B

is necessary only if you’re using Java SE 5

Petr Blaha’s
blog:
Developing
Web services
for Mustang
in Netbeans.

java.sun.com/javaee/
downloads/index.jsp

E

Java SE Web Services

Java EE 5
SDK/SJSAS,
Java EE 5’s
Reference
Implementation.

WSDL file.

method, the web service can be deployed
to a simple web server provided by the
JAX-WS runtime. Update the project’s Main

Steps to create a Client
Developing a web service client with NetBeans 5.5 is even simpler.

B�
Listing 1. The CircleFunctions class, a full web service implementation.
package geometricalws;
import
import
import
import

javax.jws.WebMethod;
javax.jws.WebParam;
javax.jws.WebService;
javax.jws.soap.SOAPBinding;

@WebService(name=”Circle”, serviceName=”CircleService”, portName=”CirclePort”)
@SOAPBinding(style=SOAPBinding.Style.RPC)
public class CircleFunctions {
@WebMethod(operationName=”area”)
public double getArea(@WebParam(name=”r”) double r) {
return Math.PI * (r * r);
}
@WebMethod(operationName=”circumference”)
public double getCircumference(@WebParam(name=”r”) double r) {
return 2 * Math.PI * r;
}
}

A1

A
Figure 1.
Adding JAX-WS
support to a
common Java
project (only
necessary with Java
SE 5).
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Create another Java Application project
and name it (say) “ClientProject”. If you’re

A
Figure 2.
Creating a
web service
client from
its live WSDL
document.

using Java SE 5, add the JAX-WS 2.0 li-

A2

brary to the project, as before.
Right-click on the project and choose
New>Web Service Client. Then fill the
WSDL URL field with the URL for the web
service we just published (see Figure 2).
Also set the package name for the client
artifacts (these are Java classes which will
be generated from the WSDL); I used “circle.client”. Click Finish, and a node named
CircleFunctions should be created under
Web Service References.

A
Figure 3.
Creating the
web service
client invocation
interactively.

Open Main.java in the source editor,

A3

expand Web Service References and locate the node CircleFunctions-CircleService-CirclePort-area. Then drag it to the
editor inside the main() method in the

Main class. NetBeans will generate code
that invokes that operation (see Figure

Robert
Eckstein
and Rajiv
Mordani’s
article about
JAX-WS 2.0
With the
Java SE 6
Platform.

java.sun.com/developer/
technicalArticles/J2SE/jax_ws_2

3). Next, change the value for the web
service operation argument (r). Listing 3
contains the finished source (after tweaking the generated code a little). Finally,
run the client project. For r = 10.0, the
following message should appear in the
output:

B�
Listing 2. The Main class, a full web service server.
package geometricalws;

Article comparing various (SOAP)
binding
styles.

www-128.ibm.com/developerworks/
webservices/library/ws-whichwsdl/

import javax.xml.ws.Endpoint;

38 N NetBeans Magazine

public class Main {
public static void main (String[] args) {
String wsAddress = “http://localhost:8765/GeometricalWS/CircleFunctions”;
Endpoint.publish(wsAddress, new CircleFunctions());
System.out.println(“Web service was published successfully.\n”+
“WSDL URL: “ + wsAddress + “?WSDL”);
// Keep the local web server running until the process is killed
while (Thread.currentThread().isAlive()) try {
Thread.sleep(10000);
} catch (InterruptedException ex) {}
}
}

Java SE Web Services

Result = 314.1592653589793

A

A

A5

A

A6

A

B�
Listing 3. The client project’s Main class.

C

Deploying the service
in a Java EE container

Figure 4.
Creating a Web
application that
depends on the web
service project.

As we’ve seen up to now, a Java EE application server is not required to bring up a web
service. But what if we had to make the service available in a Java EE container? We can
just create a “wrapper” Web application that
reuses all code written for our Java SE app.
Start by creating a Web app in NetBeans:
File|New Project>Web>Web Application.
Then set its target server to Sun Java
System Application Server (if asked). Go

Figure 5.
Inspecting the web
service, deployed
as a Java EE web
application in SJSAS.

to Properties>Libraries, click Add Project and select the root directory of the
GeometricalWS project, as in Figure 4.
Deploy the web application to the
container, with the project’s Deploy Project
action. If you open SJSAS’s admin console,
the Circle web service should be among
the listed web services (Figure 5).
The Test button allows you to test the web
service from the admin console (Figure 6).
After invoking an operation, you can see its

Figure 5.
Testing the web
service with SJSAS’s
automatic test page.

request and response.

Conclusions
In this tutorial, we created a web service
with just a few lines of web-service specific code (like annotations in the service
implementation and publishing in the main
class). Then we created a client without
manually writing any code – just by using
NetBeans’ wizards and drag-and-drop features. Finally, we deployed the same web
service in a Java EE server, again not having to write additional code. This shows
how you can develop web services that are
reusable both in Java SE and Java EE environments.

package clientproject;
import circle.client.Circle;
import circle.client.CircleService;
public class Main {
public static void main(String[] args) {
try { // Call Web Service Operation
Circle port =
new CircleService().getCirclePort();
double r = 10.0;
double result = port.area(r);
System.out.println(“Result = “+ result);
} catch (Exception ex) {
// TODO handle custom exceptions here
}
}
}

Milan Kuchtiak
(milan.kuchtiak@
sun.com) has
worked six years for
Sun Microsystems
in the NetBeans
team, currently on
the IDE support for
Web application
development and
Web Services (JAXRPC and JAX-WS).
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Open-Source
UML Modeling
Learn to use the NetBeans UML Modeling Project
by reverse engineering a complete Java application
Fernando Lozano

T

he UML Modeling Project

and MDA tools like AndroMDA (andromda.org) have been quite suc-

(uml.netbeans.org),

which

cessful in the Java arena. MDA advocates will be happy to find that

started as a part of the

the NetBeans UML modules provide many features absent from

Enterprise Pack is now a

other open-source CASE tools, and even come with an extensible

separate download provid-

Design Pattern Catalog, including not only classical GoF patterns

ing full UML support in NetBeans IDE. This
article showcases NetBeans’ UML support, going through a case study where

Installing NetBeans UML Modeling
UML Modeling is available as a feature from the NetBeans Update

plication, highlighting the IDE’s modeling

Center (accessible through the IDE’s Tools menu). At the time of

features in the process.

writing, you had to check the NetBeans Update Center Beta (see

If you are an Agile Modeling advocate

Figure 1) to download it, but readers will probably find the UML
Modeling Project on the stable NetBeans Update Center when this
edition is out.

like me, your first thought might be “why

In NetBeans, select UML Modeling in the Features category and

should I care about UML support in a Java

click Add (Figure 2). You’ll see there are many modules to install

IDE?” Today, leading software engineer
authors and even UML early adopters like

NetBeans
UML Modeling
Project web
site

but also many Java EE Blueprints out-of-the-box.

we reverse engineer a working Java ap-

UML and the Java developer

uml.netbeans.org

Java EE 5 in Action with NetBeans

A1

A

A2

A

Martin Fowler and Scott Ambler stand by
“modeling on a napkin”: using models only
as sketches before building the “real soft-

Figure 1.
Selecting the
Update Center
for modules
still in beta

ware” (i.e. the source code). Indeed some
developers today dismiss modeling as unnecessary and bureaucratic.
However, UML modeling will be useful
at some point to most Java developers,
whether they’re involved in enterprise,
desktop or mobile projects. Modeling has
its role even in radical XP development,
as no significant piece of software can be
built with a minimum level of quality without some planning and design. “Traveling
light” doesn’t mean you should not model

Figure 2.
Selecting the
UML Modeling
feature

at all, but that you should do all the modeling that adds value to your project.
Not all Java developers are Agile Modeling converts though. Many prefer to embrace the MDA paradigm, at the other end
of the modeling spectrum. In Model-Driven
Architecture the idea is that your models
will generate most if not all source code,

Second Edition N 1

uml.org

UML Modeling

Official
OMG site
dedicated to
UML, where
you can
download
UML specifications and
find about
other UML
CASE tools
and tutorials

(Figure 3). After you agree to a few licenses, NetBeans starts

 Java code generation – Java pack-

downloading. When the downloads are done, click Finish to install

ages, classes and interfaces can be gen-

the modules (see Figure 4). (If you are not the only user of your

erated directly from the UML model;

development workstation, be sure to check the Global option for

 Round-trip engineering – if a UML

all modules.) Finally, after restarting NetBeans you’ll find new UML

project is linked to a Java project, chang-

project templates and configuration options in the IDE.

es in code are automatically reflected in
the model;

UML features overview
The NetBeans UML Modeling Project supports ten standard UML
diagrams: Use Case, Class, Collaboration, Sequence, Activity,
State, Component, Deployment, Object and Robustness.

 A Design Center, which provides an
extensible design pattern catalog;
 Rich-text documentation for model

Object diagrams can be built as a Collaboration diagram, and

elements created directly inside the IDE;

Robustness diagrams as Class diagrams (the standard stereotype

 Operations and attributes can be

Other features worth noticing are:

Figure 3.
Modules to
install for the
UML Modeling feature

ages inside other model elements;

Even though they’re not displayed in the New Diagram wizard,

icons for Boundary, Control and Entity are provided).

A

 Ability to nest diagrams and pack-

A3

shown in class elements using either
standard UML notation or Java syntax;
 Generation of model reports in JavaDoc format.

The Case Study
We’ll use the reverse engineering of an existing desktop application as a case study
for exploring NetBeans’ UML features. During the process, we also show hints that
are useful for forward-engineering projects
(from model to source). Readers are not
expected to be proficient in UML modeling
to follow this tutorial, but basic modeling

A
Figure 4.
Click Finish
to install
all UML
modeling
modules

knowledge will be helpful.

A

The application used for the case study was
created for NetBeans Magazine Issue One.
It’s a simple Task Manager, similar to those
provided in a PIM suite. The “Todo” application has two windows: a task list (Figure 5)
and a task editing form (Figure 6). The task
list window displays tasks ordered either
by priority or by due date, and it can filter
out completed tasks. Tasks are colored to
indicate completed, late or alert status. The
complete application is available as a download in the NetBeans Magazine’s website.
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Our application is quite simple, so re-

the sources and populate the project with model elements for Java

verse engineering it won’t be a complex

packages, classes and interfaces. (Note that for large projects

task. Even so, it is complex enough for

this may take a long time and eat up a large amount of memory.)

us to demonstrate many of NetBeans’
UML features. We’ll work through the application as if we didn’t know how it was
designed, using UML diagrams to under-

E If you experience OutOfMemory errors while reverse engineering, you can
edit the file etc/netbeans.conf inside your NetBeans installation and change
the value for –Xmx, increasing the maximum heap size from 128M to 256M or
bigger.

stand its structure and design ideas.
While scanning, the IDE shows a log window detailing the prog-

Creating the
reverse-engineering
project

ress for each source file. When the scanning finishes, click Done to
dismiss this window, and you’ll end up with a new UML project as

The Unified Process Explained, Kendall Scott

Java EE 5 in Action with NetBeans

How to use
UML as part
of a traditional software
development
process

shown in Figure 9.

Installing the UML modeling project adds
a new project category to NetBeans, with
three project templates (Figure 7).

Platform-Independent Model projects use

Anatomy of a UML Project
A UML project is organized into three containers: Model, Diagrams
and Imported Elements.

standard UML notation for class attributes

The Model container holds all elements created as part of the

and operations, and do no code genera-

model. Elements can be Classes, Interfaces, Packages, Actors,

tion. This template is useful in the initial
stages of the development process, when
all models are “conceptual” and not “phys-

A5

A

A6

A

ical”.

Java-Platform Model projects use Java

Figure 5.
The task list
window

syntax for class attributes and operations
and must be linked to a Java Application
or Library project. NetBeans will keep
both projects in sync: If you edit the code,
the UML model will change to reflect new
or changed classes, attributes and operations, and if you change the UML model,
the source code will be modified accordingly.
We’ll use the third project template,

Figure 6.
The task form
window

which populates a Java-Platform Model
from an existing Java project. Click the

New Project icon and choose the UML category. Then select Java-Platform Model by

Reverse Engineering a Java Project. Accept
the defaults for the next step, except for
selecting the Todo Java project; then click

Finish (see Figure 8). NetBeans will scan
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A
Figure 7.
UML project
templates

A7

with conceptual modeling and then move
on to physical modeling, and keep track
of which physical elements realize which
conceptual elements1.

Exploring the
reverse-engineered model
Expand the Model container and you’ll see
that it includes both application-specific

A

and standard Java packages and classes

A8

(Figure 10). As a UML model cannot ref-

Figure 8.
Creating a
UML Project
for reverseengineering a Java
Project

erence anything it does not contain or import, NetBeans creates model elements
for Java SE classes. (An alternative would
be having a UML model with the Java SE
API and import elements from it.)
Sometimes NetBeans will create duplicates, like the many List<Task> elements
you see in Figure 10. It’s better to leave
them as they are, as removing them may
delete attributes from the Java project.

A
Figure 9.
The new UML
project

A9

Diagrams, Notes, Data Types, Associations and anything else that can
be defined as part of the UML project
itself.

F1 A «realize» UML
relationship between
two model elements
states that one element represents an
abstract concept in
the problem domain,
while the related
element represents
a software construct
implementing that
concept, making it
“physical” in the software’s point of view.
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Generating a class
diagram
The Todo application has only a few

The Diagrams container provides

classes, all of which are inside the todo

quick access to all diagrams created

package and its subpackages. It would be

as part of the model. You may be surprised to see there are no

possible to create a “complete” Class Dia-

diagrams in our reverse-engineering project. That’s because a UML

gram, but for most real-world applications

model consists of model elements, which may or may not be shown

the resulting diagram would be very hard

as diagrams. Every UML diagram is a partial view of a model, and

to read and therefore mostly useless. It’s

you’ll need to choose which details to show and which to leave

usually better to start by creating a class

out. So NetBeans populates the reverse-engineered model with ele-

diagram for each package, and then check

ments but leaves the diagram creation to the developer.

the dependencies between packages or

Finally, the Imported Elements container allows a model to refer-

between a few important classes.

ence elements created as part of another model (i.e. another UML

Let’s start with the todo.model package.

Project). This is useful for organizing large models as a set of UML

Select all its elements, right click on the

projects; for example one for business logic and another for GUI

selection and choose Create Diagram from

elements. It’s also useful for reusing model elements in various proj-

Selected Elements from the context menu.

ects. And it allows for a Platform-independent UML Model that’s

Then choose Class Diagram in the wizard

referenced by a Java Platform UML Model. This way, you can start

(see Figure 11).

Java EE 5 in Action with NetBeans

A 10

partment or expand it to select specific fields to hide. After hiding

A

an element’s details, you can right-click Resize Element to Con-

Figure 10.
The new UML
project, showing
a few model
elements

tents to optimally resize it (Figure 14). (You can also hide/show a
compartment by double-clicking the compartment separators.)
After these changes, the diagram will probably need some rearrangement. NetBeans can do this using four different auto-layouts,
accessible through the last four buttons in the Diagram Editor toolbar (see Figure 15). Click the first button, for Hierarchical Layout.
This is the default layout NetBeans uses when generating a diagram from model elements. The results are shown in Figure 16.

Inferring meaning from
a generated diagram
Notice I deleted the List<Task> element from the diagram, as
well as all exception classes. When deleting an element, NetBeans
Note that the “Namespace” combobox
lists what seem to be all the packages
in the current model. In fact, every UML
package (and most other UML elements)
corresponds to a UML Namespace. You
can use namespaces for any kind of model element. Leaving the class diagram for
the todo.model package inside the todo::

gives you the choice of removing it from the diagram only, or from
the diagram and the model (see Figure 17).
I’ve shown only public methods for Parameters and TaskManager,

A 11

A
Figure 11.
Creating a
class diagram
from model
elements

model namespace makes the diagram
easier to find. It also makes it clear that
package.
The resulting diagram is shown in
Figure 12. Note that NetBeans is pretty
smart in laying out its elements. But even
with an optimized layout and a small set
of classes, the generated diagram is quite
large. The fact is there’s too much detail,
especially if we just want to understand
the relationships between elements in the
package. Fortunately you can hide most
of the excess information.
A good start is hiding all private fields and

martinfowler.com/articles.html
objectmentor.com/resources/publishedArticles.html
thoughtworks.com/byline-articles.html

the diagram refers to elements of that

Articles
about UML,
modeling,
application
design and
agile modeling

methods (Figure 13). Right-click on each
class and select Compartment>Customize,
then uncheck the entire “Attributes” com-

Second Edition N 5

A 12

and only attributes (all private) for
the Task class. That’s because I assume Task is a DTO (Data Transfer
Obect) or Value Object, and showing accessor methods wouldn’t help
in understanding the class. But for

Parameters the attributes do not map
exactly to the getters, so I assume
the class has some intelligence of
its own. I also assume TaskManager
is a DAO class, and that it uses Pa-

The UML
standard,
by its
creators

UML User Guide, Grady Booch, James
Rumbaugh, Ivar Jacobson

UML Modeling

A
Figure 12.
The NetBeansgenerated
model for all
elements
inside the todo.
model namespace.

rameters to get JDBC connection
parameters.
As you can see, reverse-engineering a model from Java code involves
a lot of assumptions and common
sense. You’ll always be making educated guesses about the role played
by each element in the application,
and using these decisions to create
your diagrams to best effect.

A
Figure 13.
Hiding details
from classes

A 13

Enhancing the
generated model
Based on the reverse engineering
done so far, we have identified the use
of common design patterns in the application. UML provides a nice feature
to make these explicit in a model: stereotypes2. A few standard stereotypes
are defined in the UML standard, and

A
Figure 14.
Optimally resizing a class

A 1

you can create new ones freely. We’ll
create the «VO» and «DTO» stereotypes so
our interpretation of the purpose of each
class is explicit in the model.
To add a stereotype to a class, use the
properties window, as shown in Figure
18. An editor allows you to select existing
stereotypes or create new ones. Note that
an element can have many stereotypes, although this is not common.
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A 15

Now, if our conclusions are OK, the model
generated by NetBeans is not entirely correct. There is no part/whole relationship
between TaskManager and Parameters, so
they should not be connected by an aggregation. This should be changed to a

A 16

A
Figure 15.
Auto-layout diagram
buttons from the
NetBeans diagram
editor toolbar

A
Figure 16.
Class diagram
for the todo.
model package,
after hiding
details, deleting
elements and
applying an
auto-layout

simple association. Right-click on the aggregation (it should turn blue) and select
Transform>Remove Aggregate from the
context menu (see Figure 19).
I fact, you should expect NetBeans (or
any other UML CASE tool) to generate a
few “incorrect” associations when reverse
engineering Java sources. That’s because
UML associations have much richer semantics than Java references. All structural associations between Java classes
originate from attributes referencing other
classes/interfaces (or collections and arrays of these). Similarly to most other programming languages, Java does not distinguish between composites, aggregates

A 17

and simple associations. Also, a reference
to an instance of another class could be
there just for convenience, and not be a
structural association at all.

A
Figure 17.
By default, deleting
an element from
a diagram doesn’t
remove it from the
model

Now, if TaskManager is a DAO class,
responsible for persisting instances of

Task, it’s clear that these two classes are

Generating Dependency Diagrams

strongly coupled. Changes in Task fields

From our understanding so far, it looks like TaskManager is the

will probably require changes in TaskMan-

main class of the todo.model package. But does our model show

ager’s behavior. This can be made explicit

everything important about this package and about TaskManager?

in a UML diagram by a Dependency re-

NetBeans helps us check this by generating a dependency dia-

lationship, which is available in the UML

gram, a type of class diagram that shows everything that’s refer-

Class Diagram Palette in the Dependen-

enced by a given class. Right-click a class in either the Projects

cies category. Click on the Dependency

window or the class diagram and select Generate Dependency Dia-

tool, then on TaskManager in the diagram

gram. The diagram generated for TaskManager is shown in Figure

F2 A UML stereotype is

and on Task (also in the diagram). This

21. It’s created inside the namespace defined by the class itself,

elements to highlight

creates a dependency connecting the

so it shows in the Projects window as a child node of the class.

You can think of a ster-

two classes. The end result is shown in
Figure 20.

You can see that the only elements in the diagram that are not in
our todo.model class diagram come from the Java SE APIs. You’d

a label you can add to
specific semantics.
eotype as a subclass
or role of a kind of
model element.
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get similar results with other classes from the same package, so it’s

is the controller for some secondary usage

safe to assume the class diagram built for the package has enough

scenarios, so we should examine ListEdit-

information.

Tasks the same way we did with TaskMan-

The dependency diagram for TaskManager is an example of a “disposable diagram”. There’s no value in keeping it around after using

If we have found the main controller

it to verify that other related diagrams have enough information. You

class, the dependency diagrams for the

should delete the diagram from the model, and also the dependency

window classes should not add much new

diagrams for other classes in the same package (if you generated

information. Surprisingly, the dependency

them). The key is not to pollute your model with useless diagrams.

diagrams for TaskList and TaskForm do not

E NetBeans-generated dependency diagrams don’t take into account classes

A
Figure 18.
Adding a
stereotype to
a class

referenced inside a method body. Only attribute and method declarations are
followed, so there will be cases when you’ll need to inspect the code to find
additional dependencies and add them manually.

The todo.controller package
The todo.controller package has only two classes. A class diagram
for this simple package would be of little use, but let’s see what a
dependency diagram tells us. Figure 22 shows the dependency

A
Figure 19.
Transforming
an aggregation
into a simple
association

diagram for the ListEditTask class, already
“simplified” as we did with the todo.model

A 19

package class diagram.
Here we see many classes coming from
different packages. Either we have found a
crucial class for the application, or the application design is a mess. Method signatures
may help us understand how these classes
are related to each other. They suggest ListE-

ditTasks is an event listener for both TaskList

A

and TaskForm. It looks like ListEditTasks reacts

Figure 20.
Class diagram model
for the todo.model
package after changing associations
between elements.
Note the dependency
from TaskManager
to Task, and that the
association from
TaskManager to
Parameter is no
longer an aggregation. Note also the
stereotypes for TaskManager and Task.

to those events by calling TaskManager meth-
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ager.

ods, acting as a workflow controller for the
application.
Note also that TaskList and TaskForm are the
two windows in the application. The fact that
both are connected to ListEditTasks strongly
suggests it’s the main controller class for the
application.
The

dependency

diagram

for

CreateOpenTaskList shows connections to
TaskList and TaskManager, similar to the ones
from ListEditTasks. It seems CreateOpenTaskList

A 20

show any connection with ListEditTasks. But
they do show a new connection with Action-

A 18

Java EE 5 in Action with NetBeans

Support, which is a Swing ActionListener.

attribute declara-

ListEditTasks is also an ActionListener, so

tions, to find a con-

there may be some indirect connection

nection from TaskList

from the window classes to the main con-

(or

troller class.

ListEditTasks.

TaskForm)

to

Event-driven programming is meant to
reduce coupling between classes, and it
succeeds so well that there’s no way, just
by analyzing Java method signatures and

A diagram for the
application UI
Figure 23 shows what we’ve learnt (and guessed) so
far about the Todo application user interface. The diagram was

A 21

built by merging information from ListEditTasks, TaskList and Task-

Form dependency diagrams.
Starting with the ListEditTask dependency diagram, I added the

ActionSupport and Task by dragging these from the Projects window

A
Figure 21.
Dependency Diagram for
TaskManager

to the diagram area. NetBeans automatically adds connections
to others elements in the diagram. Then I simplified the classes’
presentation, corrected associations and added new dependency
links, as done before for the todo.model package class diagram.
The finished diagram is more than just a ListEditTask dependencies diagram, so I renamed it to CoreTodoDiagram and moved
it to the todo package. It gives us a pretty good picture of the
application structure, but

A

still doesn’t help understand-

Figure 22.
Dependency
Diagram for ListEditTasks

ing how the ListEditTasks
class

actually

reacts

to

user interface events from

TaskList and TaskForm. We
could guess ActionSupport
has a role in this, but so far
we don’t know exactly what
role. Perhaps it’s a utility
class that could be deleted
from the diagram…
The fact is, UML class
diagrams are good to show
static structure, but not dynamic behavior. Fortunately,
the

UML

provides

other

diagrams that help us understand how an application
behaves at runtime.

Extreme Programming Explained, Kent Beck

A 22

If you want to
use an Agile
Modeling
process
instead of a
“traditional”
one
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A 23

Generating Sequence Diagrams
Some
freely
available UML
tutorials

bdn.borland.com/article/0,110,31863,00.html
sparxsystems.com.au/UML_Tutorial.htm
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A
Figure 23.
Class diagram
for the Todo
application user
interface

We’ve been working under the assumption that the window class-

ation. Note that it refers to class instances

es (TaskList and TaskForm) generate Swing Action events, which are

and not to the classes themselves. A solid

somehow dispatched by ListEditTasks. ListEditTasks should register

arrow represents a message, that is, a

itself as an ActionListener for TaskList, and then TaskList should fire

Java method call (in UML terms, an opera-

Action events to ListEditTasks.

tion call). A dashed arrow is either a mes-

Note that ListEditTasks has only a constructor that receives a view
(ListTasks) and a model (the DAO class, TaskManager) as parameters. Looking at the constructor code in the source Java project
we can see this listener registration happening.

sage return or a “create” message, i.e. the
creation of a new object.
Again, the automatically generated diagram comes with too much detail. Remov-

Who calls the ListEditTasks constructor? The application main()

ing the args, length, err and System objects,

method is a good candidate. Expand the todo.Main class node to

and moving the elements around should

show the main() operation (UML calls “operation” what Java calls

solve this (see the result in Figure 25).

“method”), then right-click and choose Reverse-Engineer operation.

The diagram shows that main() just con-

In the wizard chose a Sequence Diagram and accept all defaults.

structs instances of the classes we have

The result will be a new diagram node under the operation’s node.

already identified as being the main ones

Figure 24 shows the diagram that NetBeans creates.

for the application, and that all are con-

An UML sequence diagram shows the message flow among a set
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of objects during the execution of an oper-

nected by the ListEditTasks constructor. So

far we’ve gleaned the same information

addActionListener(), confirming that ListEditTasks handles Action

we had expressed in the class diagrams.

events generated by TaskList. This is the missing connection from

But it’s important to confirm our guesses.

TaskList to ListEditTasks.

The fact the main() operation creates

NetBeans won’t follow a nested class from one operation to

no instances of other classes, and that

another. So the message addActionListener from ListEditTasks to

it doesn’t call operations other than con-

TaskList is missing in the sequence diagram. It’s helpful to add this

structors and setVisible() for the TaskList

message manually, to get a complete picture of all connections

window, makes us confident of not miss-

between the Todo application main classes.

ing any important class.

NetBeans also won’t create a sequence diagram from multiple

Fundamentals of Object-Oriented
Design in UML, Meilir Page-Jones

Java EE 5 in Action with NetBeans

About
UML
and OO
design

operations (as it can from multiple classes). If it could, a sequence

Interpreting
sequence diagrams

diagram generated from both main() and the ListEditTasks constructor would show all connections that are being made. That’s

The main() method sequence diagram

understandable, as a sequence diagram following nested calls

shows connections made from ListE-

would probably be very big (how many levels down are enough?). It

ditTasks to TaskManager and TaskList

would also probably create a diagram where one operation “sees”

(we’re ignoring the connections from

the inner workings of others, violating OO encapsulation.

CreateOpenTaskList to TaskList and Pa-

We still need a diagram showing event handling. We also need to

rameters). But the diagram doesn’t show

clarify the role ActionSupport plays in the Todo application. Again

connections going the other way, that is,

looking at the code, we can see the window classes delegate all

from TaskList to ListEditTasks to dispatch

Action event dispatching to the ActionSupport class. This is done

Action events. We know a view class has

so the window classes themselves don’t have to manage multiple

to send events to its controller, and that a

event listeners. This way TaskList can send Action events to both

model class has no knowledge about its

controller classes, ListEditTasks and CreateOpenTaskList.

controller – so there are no other missing
connections.

By digging a little deeper into the code, we can see that each
button or menu item from the window classes provides a different

If you follow the code, you’ll see that the

actionCommand string. The controller classes use this property to

ListEditTasks constructor calls TaskList.

know which operation was requested by the user and then execute

A 2

A
Figure 24.
Sequence diagram generated
by NetBeans
for the main()
operation
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it. So they don’t need to know which Swing component

more clearly to other developers. If you are

(from the window classes) generated which event.

serious about reverse engineering applica-

This isolates the controller classes from the inter-

tions, you’ll inevitably have to create some

nal structure of the view (window) classes.

diagrams on your own.
A “cross-level” sequence diagram is use-

A hand-made diagram

ful in understanding complex interactions

We can’t fully automate reverse

among objects – like event handling for the

engineering, but we can docu-

Todo application, which involves TaskList,

ment the knowledge gleaned

ListEditTask, ActionSupport and TaskMan-

from the reverse-engineer-

ager. NetBeans makes it easy to create

ing process in the form
of UML diagrams, and
communicate

A

A 25

Figure 25.
Sequence
diagram for the
main() operation with excess
detail removed

A
Figure 26.
Sequence
diagram for
the event
handling
between
view and
controller
classes
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A 26

it

such diagrams.
First, select the todo package, right-click
and select New Diagram. Choose Sequence

Java EE 5 in Action with NetBeans

Diagram, and name it
ActionEventSequence.
From the Projects window,
drag the elements JButton (javax.

swing), ActionEvent (java.awt.event), ActionSupport (todo.view), ListEditTasks (todo.

it is represen-

control), TaskForm (todo.view), Task (todo.

tative of all other

model) and TaskManager (todo.model).

Action events for the Todo

Connect these from left to right, using

application. There’s no need to

either the Syncronous Message or the

build sequence diagrams for each remaining button or menu item.

Create Message from the Sequence Dia-

If a developer understands this diagram and how the Save button

gram Palette. Then, for each message,

Action event is handled by the application, he can figure out how all

right-click it and select Operations from

other Action events are handled.

the context menu to see all operations

This ends our case study. We now have a model rich enough so

supported by the message’s target.

any developer can understand and maintain the Todo application.

C

The sequence of messages is create,

We could consider drawing other UML diagrams, like Use Case or

actionPerformed(),

actionPerformed(),

Deployment, but these would probably add little value in our case.

getActionCommand(), getTask(), create,

An important part of doing good modeling is knowing when to stop

isNewTask(), and finally addTask(). The

modeling.
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end result should be like Figure 26.
The diagram shows how the core class-

Conclusions

es collaborate to perform a user action.

In the past, modeling was done using expensive proprietary tools

As a sequence diagram should describe a

with steep learning curves. This prevented most development

specific sequence of messages, we chose

teams to effectively use UML models and hindered adoption by

the Save button (a JButton) from TaskForm

most small and medium shops. Modeling was performed mainly by

when it’s used to add a new task.

“Business Experts” and “System Analysts”, sometimes by a “Soft-

Clicking Save starts the sequence, and

ware Architect”. And many of those never came close to real Java

the resulting event is routed by Action-

source code. Also CASE tool developers were often unaware of

Support to ListEditTask, which queries the

the state-of-the-art in enterprise software development in general

actionCommand property from ActionEvent

and the Java platform in particular.

object (e) for which operation to perform.

All this is changing with the full open-source UML support in Net-

Then it asks the TaskForm for the updated

Beans. Having UML modeling seamlessly integrated in the IDE

Task object, which is sent to the TaskMan-

encourages developers to use models and diagrams, improving

ager to be saved to the database.

both communication between team members and the quality of

Although this sequence diagram was

OO designs. The UML Modeling Project provides developers, from

created to describe a specific message

Agile Modeling fans to MDA advocates, with a powerful toolset that

sequence (a click on the Save button)

enables ubiquitous and effective modeling.
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Introducing the

NetBeans

Strategic Partner
Program

While NetBeans is a powerful IDE and platform all by
itself, companies adding new features and capabilities
via plug-in modules amplify the value to developers
Matt Volpi

A

s an open-source project, NetBeans relies on contributions

for their contribution to the enhancement

and feedback from the community to consistently meet the

and growth of NetBeans.

needs and requirements of software developers in a number
of disciplines. Companies that have committed to support-

Program beneﬁts

ing NetBeans by building plug-in modules and recommending

The NetBeans Strategic Partner Program

NetBeans to their developer communities now have a new set of benefits

offers a unique set of technical and

5 N NetBeans Magazine

Introducing the NetBeans Strategic Partner Program

co-marketing benefits to qualifying com-

Pack and the Sun Java Wireless Toolkit. This package, called the

panies. Strategic Partners get access to

Sprint Mobility IDE, is available from the Sprint Application Devel-

technical support, the opportunity to

oper Program site.

sponsor and present at NetBeans events,
access to 4.5 million developers via the Sun

InsiTech

Developer Network, and NetBeans.org web,

InsiTech’s (insitechinc.com) emerging Java technology called XTT

e-mail properties and other co-marketing

is an application development framework for rapid creation of rich,

opportunities. Strategic Partners are also

ultra-thin, Java interfaces. Solutions developed in XTT are distributed

invited to exclusive briefings on NetBeans

applications that can be deployed and run without any modifications

plans and activities.

from LAN to the Internet, on any operating system, and use a variety

To qualify, Strategic Partners need only
meet the criteria of building a NetBeans

of data sources (relational, object-oriented, multi-value, etc.). XTT is
a 100% pure Java application and plugs into the NetBeans IDE.

plug-in and/or recommending NetBeans
to a large external or internal developer

Sony Ericsson

community. Individuals and companies

Sony Ericsson (sonyericsson.com) is a top mobile device manufac-

that use and endorse NetBeans are eligible

turer and has collaborated with NetBeans around Java ME in a number

to become NetBeans Community Partners.

of areas. Developers targeting Sony Ericsson devices can use the Net-

This provides a mention on the NetBeans.

Beans Mobility Pack and the Sony Ericsson SDK for the Java Platform

org web site as well as usage of the Net-

to create MIDP applications, as well as using Sony Ericsson’s new

Beans Community Partner logo.

Mobil JUnit testing utility. Additionally, developers targeting UIQ-based
Sony Ericsson smartphones can use the NetBeans Mobility Pack for

Meet some of the
Strategic Partners
New Strategic Partners are joining the

CDC to create Xlets and MIDlets for the CDC runtime.
TRIEMAX Software

program all the time and are featured on

TRIEMAX Software (triemax.com) is the manufacturer of Jalopy,

the NetBeans web site. Here are some of

a source code formatter for the Java programming language. It

the companies that have already jumped

layouts any valid Java source code according to some widely con-

on the NetBeans bandwagon and are help-

figurable rules allowing projects to meet a certain coding style with-

ing NetBeans grow.

out putting a formatting burden on individual developers. Jalopy
includes a plug-in for the NetBeans IDE and aims to support the

Sprint
Sprint Nextel (sprint.com) is one of the
largest U.S. Mobile operators and has

widest range of coding styles and offers more than 400 distinct
configuration options accessible through a graphical customization
dialog, to let developers use their desired formatting output.

been a pioneer in bringing mobile Java
services to its business and consumer cus-

Conclusions

tomers. To help its application developer

The above are just a taste of the many companies participating

community target its wide range of devices

in the NetBeans Strategic Partner Program. To read more about

in its portfolio, Sprint has worked with Sun

the program, Strategic Partners, or apply for membership in ei-

Microsystems to create a customized

ther the Strategic or Community Partner Programs, please visit

version of NetBeans, NetBeans Mobility

netbeans.org/community/partners.

C
Matt Volpi (matt.
volpi@sun.com) is the
Product Line Manager
for mobility tools at
Sun Microsystems
and is responsible
for the NetBeans
Mobility Pack.
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BPEL
Designer
Kick Start

Exploring NetBeans’ Visual Design
Capabilities to Create a BPEL Process
and a Composite Application
Sherry Barkodar

r

BPEL Designer Kick Start

T

his

tutorial

illustrates

Creating the sample project

and

From the IDE’s main menu, choose File>New Project. In the

testing a synchronous BPEL

Categories list, select Samples>Service Oriented Architecture, and

process

then Synchronous BPEL Process (see Figure 2).

deploying,

executing
using

NetBeans

5.5 with Enterprise Pack. A

Click Next. In the Project Name field, type “SynchronousSample”

synchronous BPEL process represents a

(this is the default value). Optionally in the Project Location field,

simple synchronous flow: it takes an input

use Browse to select a different folder for the project files.

message and sends that
message back synchro-

A

A1

Figure 1.
A successful
server
startup.

nously. A client starts the
synchronous process by
invoking

a

request-re-

sponse operation. After
invocation, the client is
blocked until the process finishes and returns the result.

A2

Conﬁguring the
environment

A
Figure 2.
Creating the
BPEL process

Before you can deploy your application,
the Sun Java System Application Server and
JBI runtime must be configured correctly
and running. To configure the environment:
1. Click the Runtime tab to open the

Runtime window, and expand the Servers
node.
2. If you have a default Enterprise Pack
installation the Servers node already contains a Sun Java System Application Server

9 node. In the Runtime window, right-click
this node and choose Start. If the Start option is not available, the server is already
running and you can skip the next step.
3. Wait until a completion message

A3

A
Figure 3.
Files in the
sample
application

appears in the Output window (see
Figure 1). When the server is running,
the IDE displays a green arrow on the
Sun Java System Application Server 9 node.
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Click Finish. The Projects window now contains two project
nodes: one for a BPEL project called SynchronousSample,
and

one

for

a

Composite

Application

project

called

SynchronousSampleApplication.
Note

that

there

is

a

 The Palette of BPEL elements is located to the right of the Source Editor.
 The Navigator window shows the
BPEL logical view of the BPEL process.

broken

reference

in

the

SynchronousSampleApplication node. This is expected. The

Exploring the WSDL Editor

Composite Application has a dependency on the JBI Module. We’ll

The WSDL Editor enables you to cre-

resolve the broken reference later in the article, when we deploy

ate and edit Web Services Description

the project.

Language (WSDL) files. It includes a Design
view and a Source view. To see the Design

Exploring the BPEL Project

View, in the Projects window double-click

In the Projects window, expand the SynchronousSample node;

the SynchronousSample.wsdl file. In this

then expand Process Files. This node contains the following items

view, the WSDL file appears as a tree com-

(see Figure 3):

ponent where you can configure the file’s
elements and attributes (see Figure 5).

 SynchronousSample.bpel, the BPEL process
 SynchronousSample.wsdl,

the

process

web

service

interface.
 SynchronousSample.xsd, the schema file.
Double-click the SynchronousSample.bpel node (see Figure 4).
Notice the following:

A
Figure 4.
Designing the
BPEL process
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To see the Source View, click the Source
button. The underlying XML source code
appears, as shown in Figure 6.

Adding an If activity
In the Projects window, double-click on

 The Source Editor has a tab for SynchronousSample.bpel.

SynchronousSample.bpel. The IDE displays

 The SynchronousSample diagram is shown in the Design

the SynchronousSample.bpel diagram in the

view. The Design view allows you to visually model a business

Design view. In the Source Editor, change

process. The BPEL Design tool automatically generates BPEL

to the Design view (if you’re not there al-

code that corresponds to the visual design.

ready). In the Structured Activities section

A4

BPEL Designer Kick Start

A

A5

Figure 5.
WSDL Editor
Design view

A

A6

Figure 6.
WSDL Editor
Source view

A7

A
Figure 7.
Adding an If
activity
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A
Figure 11.
First Assign
activity

of the Palette, select the If activity and drag it to the design area

A 11

between Start and Assign. The IDE provides visual cues showing
where you can drop the selection. This adds an If activity called If1
(see Figure 7).
In the Design view, click the new If1 activity. The BPEL Mapper
appears at the bottom of the IDE (see Figure 8). (If the BPEL Mapper is not visible, choose Window>BPEL Mapper.) We’ll use the
BPEL Mapper to define the Boolean condition for the If. The sections at the top of the BPEL Mapper make up the Method Palette.
From the Method Palette, click Operator and select Equal
(

). The Equal method appears in the middle portion of

the BPEL Mapper (the Editor). Click String and select String Literal
(

) from the drop-down list. The String Literal box

appears in the editor (you may need to drag it to the side). Type
“Hello World” in the String Literal and press Enter. Then move the
String Literal box and the Equal box to the middle of the editor
(see the current mapping in Figure 9).
In the left side of the BPEL Mapper, un-

A
Figure 8.
BPEL Mapper
window

A8

der Variables, expand inputVar>inputType.
Drag paramA onto the any1 part of the
Equal method. Select the small square on
the right side of the String Literal box; then,
when the hand cursor is visible, drag a connecting line to the any2 part of the Equal
method. Finally, from the Equal method,
drag the return boolean section on to the

A
Figure 9.
First step of
the mapping

A9

Result (in the rightmost part of the BPEL
Mapper).

Adding an
Assign Activity
In the Design view, drag the existing
Assign1 activity to the If1 activity. Place

A
Figure 10.
Completed
mapping

A 10

the activity between the two large X icons
in the If1 activity area, as in Figure 11.
Open the Basic Activities section in the Palette and drag a new Assign activity to the
design area, placing it to the right of the
existing one (Figure 12).
Select the new Assign2 activity. From
the Method Palette of the Mapper, click on
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String and select concat (

project makes the service assembly

) from the drop-down list. The concat

available to the application server,

method appears in the editor. Double-

thus allowing its service units to be

click the first field in the concat box

run.

and type “Hello” followed by space,

Projects

click outside the box.

S y n c h ro n o u s S a m p l e A p p l i c a t i o n

inputVar>inputType. Drag paramA onto

A
Figure 12.
Adding a second
Assign activity

To add the JBI module, in the

in the first string. Then press Enter or
In the left side of the Mapper, expand

A 12

window,

right-click

the

project node and choose Add JBI
Module

from

the

pop-up

menu.

the string2 part of the concat method,
the second field. On the right of the

A 13

A

A 14

A

A 15

A

A 16

A

Mapper, expand outputVar>resultType.
Drag the return string part from the
concat method onto the paramA under

Figure 13.
Assign2
activity
mapping

outputVar>resultType. See Figure 13.
This concatenates the string Hello to
the input and copies the statement
into the output.

Deploying the project
Before you deploy the BPEL project,
you need to add the JBI module to the
deployment project. Deploying the

Figure 14.
Adding a JBI
Module to the
Synchronous
Sample
Application

Figure 15.
Deployment
results for the
Composite
Application

Figure 16.
Results for the
first test.

Second Edition N 61

BPEL & SOA

A

paramA>Sherry<syn:paramA> .

A 17

Figure 17.
Confirmation
for saving
to an empty
Output.xml

Then save the project.
Double-click Output.xml and notice that before the test is run this
file is empty. Each time the test
is run, the current output is com-

A

pared to the contents of Output.

A 18

Figure 18.
Results for the
second test.

The Input will be copied to Output
when Output is empty.

Testing the
Synchronous
SampleApplication
In the Projects window, expand to
SynchronousSampleApplication>
Select the SynchronousSample project and click Add Project

Test>TestCase0. The TestCase0

JAR Files (see Figure 14). In the Projects window, expand the

contains two XML files: Input.xml

SynchronousSampleApplication project node and then the JBI Mod-

Output.xml. Right-click the TestCase0 proj-

ules node. Notice that a SynchronousSample.jar node has been

ect node and choose Run. A pass message

added.

should be shown in the Output window (see

To

C
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deploy

the

Composite

Application,

right-click

the

node
and

Figure 16).

SynchronousSampleApplication project node and choose Deploy

Right-click the MyTestcase node, and

Project; then confirm the use of the SJSAS application server. You’ll

choose Run from the context menu. This

see a message like the one shown in Figure 15 in the Output window

is a special case where the Output file is

(if the Output window is not visible, choose Window>Output).

empty, so the output is written to Output.
Before that, a confirmation dialog is dis-

Testing the composite application

played (Figure 17); click Yes. Notice the

You can enhance the Composite Application project by adding test

failed message (Figure 18). Repeat the

cases, binding to the operation, supplying input, and then using the

last test. After the first run, the Output.xml

Tester.

file is no longer empty, so its contents are

In the Projects window, expand the SynchronousSampleApplication
project node, right-click the Test node, and choose New Test

preserved and are not overwritten by the
new result. And the test passes.

Case from the context menu. The New Test Case wizard opens.
For Name, enter (say) “MyTestcase” and click Next. Expand
SynchronousSample-Process Files, select SynchronousSample.
wsdl and click Next.

Conclusions
In this tutorial, you’ve seen how to use
the NetBeans BPEL designer to create a

Select operation1 and click Finish. Notice that in the project tree,

synchronous process, and how productive

under Test, a new folder MyTestcase is created, containing two

developing, testing and deploying compos-

files: Input and Output. Double-click Input

ite applications is with the new features in

and in the Body con-

tents replace <syn:paramA>?string?<syn:paramA> with <syn:

the NetBeans Enterprise Pack.

